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WITH EFFECT FROM THE ACADEMIC YEAR 2020-2021

DSP LAB
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Duration of University Examination 2 Hours
University Examination (SEE) 50 Marks
Sessional (CIE) 25 Marks
PC463EE (EEE)
PCS07EE (EIE)
1. Generation of different discrete signal sequences and Waveforms.
2. Basic Operations On Discrete Time Signals
3. DFT Computation and FFT Algorithms.
4. Verification of Convolution Theorem.
5. Verification of sampling theorem.
6. Design of Butterworth and Chebyshev LP and HP filters.
7. Design of LPF using Rectangular, Hamming and Kaiser Windows.
8. To perform linear and circular convolution for the given sequences.
9. Design and implementation of FIR and IIR filter.

10.Computation of DFT using DIT and DIF algorithm.
11. Generation of basic waves.
12. Impulse response.

At least ten experiments should be completed in the semester
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INTRODUCTION

MATLAB, which stands for MATrix LABoratory, is a state-of-the-art
mathematical software package for high performance numerical computation and
visualization provides an interactive environment with hundreds of built in functions
for technical computation, graphics and animation and is used extensively in both
academia and industry. It is an interactive program for numerical computation and
data visualization, which along with its programming capabilities provides a very
useful tool for almost all areas of science and engineering.

At its core ,MATLAB is essentially a set (a “toolbox”) of routines (called “m

files” or “mex files”) that sit on your computer and a window that allows you to create
new variables with names (e.g. voltage and time) and process those variables with any
of those routines (e.g. plot voltage against time, find the largest voltage, etc).
It also allows you to put a list of your processing requests together in a file and save
that combined list with a name so that you can run all of those commands in the same
order at some later time. Furthermore, it allows you to run such lists of commands
such that you pass in data.

MATLAB Windows:
MATLAB works with through these basic windows

Command Window

This is the main window .it is characterized by MATLAB command prompt
>> when you launch the application program MATLAB puts you in this window all
commands including those for user-written programs ,are typed in this window at the
MATLAB prompt

The Current Directory Window

The Current Directory window displays a current directory with a listing of its
contents. There is navigation capability for resetting the current directory to any
directory among those set in the path. This window is useful for finding the location
of particular files and scripts so that they can be edited, moved, renamed, deleted, etc.
The default current directory is the Work subdirectory of the original MATLAB
installation directory

The Command History Window

The Command History window, at the lower left in the default desktop,
contains a log of commands that have been executed within the Command window.
This is a convenient feature for tracking when developing or debugging programs or
to confirm that commands were executed in a particular sequence during a multistep
calculation from the command line.

Graphics Window

The output of all graphics commands typed in the command window are
flushed to the graphics or figure window, a separate gray window with white
background color the user can create as many windows as the system memory will
allow.

Edit Window
This is where you write edit, create and save your own programs in files called
M files.
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Input-output

MATLAB supports interactive computation taking the input from the screen
and flushing, the output to the screen. In addition it can read input files and write
output files

Data Type

The fundamental data —type in MATLAB is the array. It encompasses several
distinct data objects- integers, real numbers, matrices, character strings, structures and
cells. There is no need to declare variables as real or complex, MATLAB
automatically sets the variable to be real.

Dimensioning

Dimensioning is automatic in MATLAB. No dimension statements are
required for vectors or arrays .we can find the dimensions of an existing matrix or a
vector with the size and length commands.

Where to work in MATLAB?
All programs and commands can be entered either in the
a) Command window
b) As an M file using MATLAB editor

Note: Save all M files in the folder 'work' in the current directory. Otherwise
you have to locate the file during compiling.
Typing quit in the command prompt>> quit, will close MATLAB Development
Environment.
For any clarification regarding plot etc, which are built in functions type help topic i.e.
help plot

Basic Instructions in MATLAB
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1. T =0: 1:10 This instruction indicates a vector T which as initial value 0 and
final value 10 with an increment of 1 Therefore
T=[012345¢6 7289 10]

2. F=20:1:100
F = [20 21 22 23 24 ... 100]

3. T=0:1/pi: 1
T= [0, 0.3183, 0.6366, 0.9549]

4. zeros (1, 3) The above instruction creates a vector of one row and three
columns whose values are zero Output=[0 0 0]

5. Transpose a vector
Suppose T= [1 2 3],
Then transpose
=1
2
3
6. Empty vector
Y = []
Y

[]
6. Matrix Operation

a)If a=[12 3] b= 1[45 6]
a.*b = [4 10 18]
b)If v = [0:2:8]
= [0 2 4 6 8]
v(1l:3)
ans [0 2 4]
v(l:2:4)

A =
123
345
6 7 8
A(2,3)
ans 5
A(l:2,2:3)
ans =
2 3
4 5
A(:,2)
ans =
2
4
7
A(3,:)
ans =
6 7 8
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Operations on vector and matrices in MATLAB

MATLARB utilizes the following arithmetic operators;

+ Addition

- Subtraction

* Multiplication

/ Division

A Power Operator
¢ transpose

Relational operators in MATLAB

Operator Description

: Less than
<= Less than or equal to
: Greater
>= Greater or equal to
== Equal to
—= Not equal to

Control Flow in MATLAB

1) Syntax of the for loop is shown below
for k = array
commands
end

Lab Manual

The commands between for and end statements are executed for all values

stored in the array.
2) Syntax for the if loop
if expression
commands
end
This construction is used if there is one alternative only.
Two alternatives requires the following construction
if expression
commands (evaluated if expression is true)
else
commands (evaluated if expression is false)
end
3) Syntax of the switch-case construction is
switch expression (scalar or string)
case valuel (executes if expression evaluates to valuel)
commands
case value2 (executes if expression evaluates to value2)
commands

otherwise
statements
end
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Switch compares the input expression to each case value. Once the match is
found it executes the associated commands.

Basic Functions in MATLAB
1) Plot Syntax: plot (x,y)
Plots vector y versus vector x. If x or y is a matrix, then the vector is plotted
versus the rows or columns of the matrix.

2) Stem Syntax: stem(Y)
Discrete sequence or "stem" plot.
Stem (Y) plots the data sequence Y as stems from the x axis terminated with
circles for the data value. If Y is a matrix then each column is plotted as a
separate series.

3) Subplot Syntax: Subplot (2 2 1)
This function divides the figure window into rows and columns.
Subplot (2 2 1) divides the figure window into 2 rows and 2 columns 1
represent number of the figure.

Subplot (3 1 2) divides the figure window into 3 rows and 1 column 2
represent number of the figure

13,1,1)

23,12

3(3,1,3)

4) Disp Syntax: disp(X)
Description: disp(X) displays an array, without printing the array name. If X
contains a text string, the string is displayed. Another way to display an array
on the screen is to type its name, but this prints a leading "X=," which is not
always desirable.Note that disp does not display empty arrays.

5) xlabel Syntax: xlabel('string') Description: xlabel('string') labels the x-axis
of the current axes.

6) ylabel Syntax : ylabel('string")
Description: ylabel('string') labels the y-axis of the current axes.

7) Title Syntax : title('string")

Description: title('string') outputs the string at the top and in the center of the
current axes.

8) grid on Syntax : grid on

Description: grid on adds major grid lines to the current axes.
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Experiment — 1

Aim :- To generate the waveform for the following signals using MATLAB.

1) Sine Wave signal

2) Cosine Wave signal

3) Saw Tooth Wave signal
4) Square Wave signal

5) Triangular Wave signal
6) Trapezoidal Wave signal

Apparatus: Matlab Software, PC

Algorithm:-

Lab Manual

1) Enter the number of cycles, period and amplitude for respective waves.

2) Generate the signals using corresponding general formula.
3) Plot the graph.

Program:

1)% To generate a sinusoidal signal
clear all;

close all;clc;

N = input('enter the number of cycles....');
t 0:0.05:N;

X = sin(2*pi*t);

subplot(121) ;

plot (t,x);

xlabel('---> time') ;

ylabel ('---> amplitude');
title('analog sinusoidal signal');
subplot(122) ;

stem(t,x);

xlabel('---> time') ;

ylabel ('---> amplitude');
title('discrete sinusoidal signal');

Results:
enter the number of cycles....3

analog sinusoidal signal discrete sinusoidal signal

0.8 5
0.6 gl
0.4

0.2

- amplitude
-3 amplitude

-0.8}F

> <
>
ol
>
og = £
o2}
<
0.4}
-0.6 | <
C
L e
1

-—-> time

2)% To generate a Cosine Wave signal

1




Digital Signal Processing Lab Manual

clear all;
close all;

clc;

N = input('enter the number of cycles....');
t = 0:0.05:N;

X = cos (2*pi*t);

subplot(121) ;

plot(t,x);

xlabel('---> time');

ylabel ('---> amplitude');
title('analog cosine signal');
subplot (122) ;

stem(t,x);

xlabel ('---> time') ;
ylabel ('---> amplitude');
title('discrete cosine signal');
Results:
enter the number of cycles....3
analog cosine signal discrete cosine signal
1 e E e &
08t - 0.8 fp o] foll o} o
06 § 0.6 fi> fall|lo] ol Qi
0.4t . 0.4 1
(D Lo lo (D Lo
2 02t 1 & 0.2 [ H
£ ol -S| — il
A ~
{ -02f 4 7 o2t -
lo 4 o [0 O
0.4 4 04} E
06} - 06F 4 HI D> alfs 4
08} - -08F 4 D A
1 . . 1 . AN SR
0 1 2 3 0 1 2 3
---> time ---> time
3) % To generate a triangular signal
clc;
clear all;
close all;
N = input('enter the number of cycles....');
M = input('enter the amplitude....');

tl = 0:0.5:M;
t2 = M:-0.5:0;
t =[]’
for i = 1:N,
t [t,t1l,t2];
end;
subplot(211) ;
plot(t); grid on;
xlabel('---> time');
ylabel ('---> amplitude');
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title('analog triangular signal');

subplot (212) ;

stem(t) ; grid on;

xlabel ('---> time');

ylabel ('---> amplitude');

title('discrete triangular signal');

Results:
enter the number of cycles....3
enter the amplitude....4

analog triangular signal

T T T

---> amplitude

60
--> time
discrete triangular signal
it T T i T
Q| |- (O
@ o | R R A =
= A
= :
i X
2 Mg ssmnas 5 B H E H 0 PR i
= :
3 e g 50 = 60

---> time

4) % To generate a saw tooth signal
clear all;
close all;
clc;
N = input('enter the number of cycles....');
tl = 0:25;
t =[]
for i = 1:N,
t = [t,tl];
end;
subplot (211) ;
plot(t); grid on;
xlabel ('---> time') ;
ylabel ('---> amplitude');
title('analog saw tooth signal');
subplot(212) ;
stem(t) ; grid on;
xlabel ('---> time') ;

ylabel ('---> amplitude');
title('discrete saw tooth signal');
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Results:
enter the number of cycles....3
analog saw tooth signal
3 ! ; ; ! ! ; ;
) : . : :
-
=
£
£
®
A
--> time
discrete saw tooth signal
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---> time
5)% To generate a square signal
clear all;
close all; clc;
N = input('enter the number of cycles....');

M = input('enter the period....'");
y = 0:0.001:2;
for j = 0:M/2:M*N;
X =y,
plot(j,x,'k'); grid on;
hold on;
end;
for k = 0:M:M*N;
x = k+ty;
m= 2;
plot(x, m, 'k'); grid on;
hold on;
end;
for k =2:M:M*N;
x = k+ty;
m =0;
plot(x, m, 'k'); grid on;
hold on;
end;
hold off;

axis ([0 12 -0.5 2.5])
xlabel ('---> time') ;

Lab Manual
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ylabel ('---> amplitude');
title('Square signal');

Results

enter the number of cycles....4

enter the

25

125

--» amplitude

0.5

-0.5
u}

5)%

period... .4

Square signal

clear all;
close all;

clc;
N
LN=1;

x=0:0.1

:LN; %

a=length (x) ;

y=ones (1,a+10); %

z=LN:-0

.1:0; %

y3=[xy z ];
$y4=[y3 y3 y3 y3];

y4=[1’
for i

1:N,

Vxl

1 |l
b4
Vzl

y4=[y4,y3];

end;

subplot(211) ;
plot(y4); grid on;

xlabel ('---> time');
ylabel ('---> amplitude');
title('analog trapezoidal signal');
subplot(212) ;
stem(y4) ; grid on;

xlabel ('---> time') ;
ylabel ('---> amplitude');

To generate a Trapezoidal signal

is meant for linear rise

input('enter the number of cycles....');

3

o

is meant for constancy %

is meant for linear fall

%

12
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title('discrete trapezoidal signal');

Results:
enter the number of cycles....3

analog trapezoidal signal
T T T T T T T T T

> amplitude

20 40 60 80 100 120 140 160 180 200

20 0 160 200
Discussions on results:

Thus different waveforms have been generated in Matlab and plotted with respect to
time.

discrete trapezoidal signal

[IX]
%
EXX] -
= ¢
£
H
A 049
02 -”
hii

-==> time

By performing the experimentation the student will be to

1. Discuss the effect of change in number of cycles on waveform.
2. Discuss the effect of change in time duration on the waveform

3. Discuss the application and significance of each waveform in digital signal
processing.
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Experiment — 2

Aim: Write a Matlab program to verify Convolution Theorem-comparison Circular
and Linear Convolutions.

a) Write a Matlab program to implement and verify Linear Convolution.
Apparatus: Matlab Software, PC
Theory:

The mathematical definition of convolution 1in discrete time domain

MORLOMOEDWORIES

where x[n] is input signal, 4[n] is impulse response, and y[n] is output. * denotes
convolution. Here we multiply the terms of x[k] by the terms of a time-shifted /[n]
and add them up.

In this equation, x(k), h(n-k) and y(n) represent the input to and output from the
system at time n. Here one of the input is shifted in time by a value every time it is
multiplied with the other input signal. Linear Convolution is quite often used as a
method of implementing filters of various types.

Algorithm:
1) Give input sequence x[n].
2) Give impulse response sequence h[n].
3) Find the convolution y[n] using the matlab command CONV.
4) Plot x[n],h[n],y[n].

Program:

[o)

% MATLAB program for linear convolution
clc;

clear all;

close all;

disp('linear convolution program') ;
x=input('enter i/p x(n):");
m=length (x) ;

h=input('enter i/p h(n):'");
n=length (h) ;

x=[x,zeros(1l,n)];

subplot(2,2,1), stem(x);

title('i/p sequence x(n)is:');
xlabel ('---->n"'");

ylabel ('---->amplitude') ;grid;
h=[h,zeros(1,m)];

subplot(2,2,2), stem(h);

title('i/p sequence h(n)is:');
xlabel('---->n"'");

ylabel ('---->amplitude') ;grid;
disp('convolution of x(n) & h(n) is y(n):');
y=zeros (1,m+n-1) ;

for i=l:m+n-1
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y(i)=0;
for j=1l:m+n-1
if (§<i+1)
y (1)=y (i) +x (j) *h (i-3+1) ;
end
end
end
Yy

subplot(2,2,[3,4]) ,stem(y);
title('convolution of x(n) & h(n) is y(n):
xlabel('---->n"'");

ylabel ('---->amplitude') ;grid;

")

Results:

linear convolution program

enter i/p x(n):[1 2 3 4 5]

enter i/p h(n):[ 1 2]

convolution of x(n) & h(n) is y(n):

y =
1 4 7 10 13 10
ifp sequence x(n)is: i’p sequence h{n)is
6 ' . : o : :
: o i § :
Q . . Q =3 EEEEEEEES ERREEEE Taseasaas IEEEEREEE
§ 4 AAAAAAAAAAAAAA AAAAAAAAA 3
3 z z 2 | . FO— B—
£ : : £ : -
o . x o . 3
A ) SaM RRERH RRRE) R Seeeeens A : :
E T E 05 ................. ......... ........
0 T 6o 0 o—6—0—6—0
0 2 4 b g 0 2 4 b 8
-->N -=>N
convolution of x{n) & h{n) is y(n):
15 T T T T l T T T T
: : : : : ¢ :
@ : : : E
B 10 ................. , ............................... ........ ﬁ)
-3 : E : :
£ : : : :
o : . .
N B RREREPERY, IERTERLS ................................ Seeeeenn -
o i T ; ; : ;
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b) Write a Matlab program to implement and verify Circular convolution of two
given sequences.

Apparatus: Matlab Software, PC

Theory:

Circular convolution is another way of finding the convolution sum of two
input signals. It resembles the linear convolution, except that the sample values of one
of the input signals is folded and right shifted before the convolution sum is found.
Also note that circular convolution could also be found by taking the DFT of the two
input signals and finding the product of the two frequency domain signals. The
Inverse DFT of the product would give the output of the signal in the time domain
which is the circular convolution output. The two input signals could have been of
varying sample lengths. But we take the DFT of higher point, which ever signals
levels to. For eg. If one of the signal is of length 256 and the other spans 51 samples,
then we could only take 256 point DFT. So the output of IDFT would be containing
256 samples instead of 306 samples, which follows N1+N2 — 1 where N1 & N2 are
the lengths 256 and 51 respectively of the two inputs. Thus the output which should
have been 306 samples long is fitted into 256 samples. The 256 points end up being a
distorted version of the correct signal. This process is called circular convolution.
Circular convolution is explained using the following example.

The two sequences are
x1 (n) = {2,1,2,1}
x2 (n)={1,2,34 }

Each sequence consists of four nonzero points. For purpose of illustrating the
operations involved in circular convolution it is desirable to graph each sequence as
points on a circle. Thus the sequences x1 (n) and x2 (n) are graphed as illustrated in
the fig.We note that the sequences are graphed in a counterclockwise direction on a
circle.This stablishes the reference direction in rotating one of sequences relative to
the other. Now, y (m) is obtained by circularly convolving x (n) with h (n).

Algorithm:
1) Give input sequence X[n].
2) Give impulse response sequence h[n].

3) Find the Circular Convolution y[n] using the DFT method.
4) Plot x[n],h[n],y[n].

18
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Program:

clc;

clear all;

close all;

disp(‘Circular convolution program') ;
x=input('enter i/p x(n):'");
m=length (x) ;

h=input('enter i/p h(n):");
n=length (h) ;

subplot(2,2,1), stem(x);
title('i/p sequence x(n)is:');
xlabel('---->n"'");

ylabel ('---->amplitude') ;grid;
subplot(2,2,2), stem(h);
title('i/p sequence h(n)is:');
xlabel('---->n"'");

ylabel ('---->amplitude') ;grid;

disp('circular convolution of x(n) & h(n) is y(n):

yl=fft(x,n) ;
y2=fft(h,n);
y3=yl.*y2;
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y=ifft(y3,n);

y

subplot(2,2,[3,4]) ,stem(y) ;

title('circular convolution of x(n) & h(n) is y(n):");
xlabel ('---->n");

ylabel ('---->amplitude') ;grid;

Result:

Circular convolution program

enter i/p x(n):[1 2 3 4]

enter i/p h(n):[4 3 2 1]

circular convolution of x(n) & h(n) is y(n):

y=

24 22 24 30

ifp sequence x(n)is: ifp sequence h(n)is:
4 _ : ) 4@ _ :
g 3 ........... ....................... % 3 .......... (x .......................
= E =
E— 2 ........... (;:, ...................... g 2 .................................
(1] [
N A
1.: ................................... 1 ................................... )
0 0
1 2 3 4 1 2 3 4
-=->N 3N
circular convolution of x(n) & h(n) is y(n)
30 ) ; ; ! ; P
> f (“ : p :
3 9, 1| SR P R i e Y R RREREE -
%_ : % .
= : : :
[ . . X
,':\ 10 L R ............................ ............................ ............. -
D 1 1 1
1 1.5 2 25 3 3.5 4
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Discussions on results:

Thus the Linear convolution and circular convolution for discrete time signals are
obtained mathematically and graphically .Through this experiment student will be
able to

1) Discuss the effect on results if zero padding is used in the program.

2) Discuss the effect on results if zero padding is not used in the program.

3) Discuss the results in obtaining the circular convolution without using

frequency domain technique.
4) Discuss the difference between linear convolution and circular convolution.
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Experiment — 3

Aim: Write a Matlab program for computation of DFT and IDFT using Direct and
FFT method.

Apparatus: Matlab Software, PC

Theory:
DFT:

Discrete Fourier Transform (DFT) is used for performing frequency analysis of
discrete time signals. DFT gives a discrete frequency domain representation whereas the
other transforms are continuous in frequency domain. The N point DFT of discrete time
signal x[n] is given by the equation

J23m

N-1
X(k)=> xinle ¥ : k=012, N-1
-0

The inverse DFT allows us to recover the sequence x[n] from the frequency samples

1 N-1 Jj23m

Dxnle ¥ ; n=0,12, .N-1
‘NLO

x{n]

FFT:

A fast Fourier transform (FFT) is an efficient algorithm to compute the discrete
Fourier transform (DFT) and its inverse. FFTs are of great importance to a wide variety of
applications, from digital signal processing and solving partial differential equations to
algorithms for quick multiplication of large integers. Evaluating the sums of DFT directly
would take O(N 2) arithmetical operations. An FFT is an algorithm to compute the same
result in only O(N log N) operations. In general, such algorithms depend upon the
factorization of N, but there are FFTs with O(WV log N) complexity for all N, even for
prime N. Since the inverse DFT is the same as the DFT, but with the opposite sign in the
exponent and a 1/N factor, any FFT algorithm can easily be adapted for it as well.

Algorithm:

1) Get the input sequence

2) Find the DFT of the input sequence using direct equation of DFT.
3) Find the IDFT using the direct equation.

4) Find the FFT of the input sequence using MATLAB function.

5) Find the IFFT of the input sequence using MATLAB function.

4) Display the above outputs using stem function.

Program:

Shkkkkkkkkk*x Djrect DFT ***kkkkkkkk
clc;close all;clear all;
xn=input ('enter 8 inputs');
N=length (xn) ;

n=0:N-1;

k=0:N-1;

wn=exp ( (-1i*2*pi*n'*k) /N) ;
xf=wn*xn';

subplot(2,2,1) ;

stem (abs (x£f)) ;

title('dft magnitude respone');
ylabel ('magnitude') ;

xlabel ('frequncy') ;

& *kkkk*kk*k Direct IDFT **kkkxkkkk*
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WN=exp ((1li*2*pi*n'*k) /N) ;
pn=WN*xf/N;

subplot(2,2,2);

stem(abs (pn)) ;

title('idft magnitude respone');
ylabel ('magnitude') ;

xlabel ('time') ;

%******* FEFT MethOd**********
xp=fft (xn,N) ;

subplot(2,2,3);

stem (abs (xp) ) ;

title('fft magnitude respone') ;
ylabel ('magnitude') ;

xlabel ('frequncy') ;

Shkkkkkkk* TEFT method ****kxkkkx%x
xw=ifft (xp,N);

subplot(2,2,4);

stem(abs (xw) ) ;

title('ifft magnitude respone');
ylabel ('magnitude') ;

xlabel ('time') ;

Results:
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Discussions on results:
Thus from the results students will be able to
1. Discuss that the Fourier transform of a discrete time signal is also called as
Signal Spectrum.
2. Discuss the changes in the results due to more number of inputs in the given
sequences in finding the DFT and FFT.
3. Discuss that FFT performs faster and take less computational time compared
to DFT.
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Experiment — 4

Aim: Write a Matlab program to verify Sampling Theorem
Apparatus: Matlab Software, PC
Theory:

Sampling Theorem: The sampling theorem, attributed to Nyquist, Shannon,
Kotelnikov and Whittaker, is useful when calculating the sampling frequency required
for use in the Analog-to-Digital converter.

The theorem states that a band limited signal can be reconstructed exactly if it is
sampled at a rate at least twice the maximum frequency component in it.

The maximum frequency component of g(t) is fm. To recover the signal g(t) exactly
from its samples it has to be sampled at a rate fs=2fm. The minimum required
sampling rate fs = 2fm is called Nyquist rate.

Sampling is also a process of converting a continuous time signal (analog signal) x(t)
into a discrete time signal x[n],which is represented as a sequence
of numbers. (A/D Converter)

Converting back x[n] into analog (resulting in) x(t) is the process of
reconstruction.(D/A Converter)

Algorithm:

1) Input the desired frequency f, (for which sampling theorem is to be verified)
2) Generate the cosine wave, i.e a continuous-time signal given mathematically
as, x(t) =cos(2z f,t) where f represents the frequency and ¢ the time.

3) Generate the discrete-time signals for Undersampling, Nyquist sampling
andoversampling conditions.
oversampled & under sampled conditions after sampling at instants nl, n2,
n3 which are given as, ,.
a. To do this for under sampling, choose sampling frequency
fs1<2*fm. For this sampling rate T1=1/fs1,
b. For Nyquist Sampling, choose sampling frequency £s2=2*fm. For
this sampling rate T2=1/fs2.
c. For Over Sampling, choose sampling frequency £s2>£d.
4) Plot the waveforms and hence prove sampling theorem.

Program:

clc;

clear all;

%define analog signal for comparison
t=-100:01:100;

fm=0.02;

X=Ccos (2*pi*t*fm) ;
subplot(2,2,1);

plot (t, x);

xlabel ('time in sec'):;

ylabel ("x(t)");
title('continuous time signal');

23




Digital Signal Processing Lab Manual

$simulate condition for undersamplingi.e., fsl<2*fm
fs1=0.02;

n=-2:2;

x1l=cos (2*pi*fm*n/fsl);

subplot(2,2,2);

stem(n, x1);

hold on
subplot (2,2,2);
plot(n,x1,"':");

title('discrete time signal x(n) with fs<2fm');
xlabel('n'");

ylabel ('x(n)");

$condition for Nyquist plot

£s2=0.04;

nl=-4:4;

x2=cos (2*pi*fm*nl/fs2);

subplot (2,2,3);

stem (nl, x2);

hold on

subplot (2,2,3);

plot(nl,x2,"':");

title('discrete time signal x(n) with fs>2fm'");
xlabel('n'");

ylabel ('x(n)");

scondition for oversampling

n2=-50:50;

£s3=0.5;

x3=cos (2*pi*fm*n2/£fs3);

subplot(2,2,4);

stem (n2, x3) ;

hold on

subplot(2,2,4);

plot(n2,x3,"':");

xlabel ('n'");

ylabel ('x(n)");

title('discrete time signal x(n) with fs=2fm');

Results:
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continuous time signal discrete time signal x(n) with fs<2fm
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1

x(n)
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Discussions on Results:

This experiment verifies the sampling theorem in Matlab for undersampling, Nyquist
sampling and oversampling.

Thus from the results students will be able to
1) Discuss the effect of undersampling for the given signal

2) Discuss the effect of Nyquist sampling for the given signal
3) Discuss the effect of oversampling for the given signal.
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Experiment — 5

Aim: -To Design and generate IR Butterworth/ Chebyshev LP/HP Filter using
MATLAB

Apparatus Required: - MATLAB Software, PC

Theory:

The Digital Filter Design problem involves the determination of a set of filter
coefficients to meet a set of design specifications. These specifications typically
consist of the width of the passband and the corresponding gain, the width of the
stopband(s) and the attenuation therein; the band edge frequencies (which give an
indication of the transition band) and the peak ripple tolerable in the passband and
stopband(s).

The design of TIR filters is closely related to the design of analog filters, which
is a widely studied topic. An analog filter is usually designed and a transformation is
carried out into the digital domain. Two transformations exist — the impulse invariant
transformation and the bilinear transformation.

Analog to Digital Domain Mapping Techniques

Digital Filters are designed by using the values of both the past outputs and the
present input, an operation brought about by convolution. If such a filter is subjected
to an impulse then its output need not necessarily become zero. The impulse response
of such a filter can be infinite in duration. Such a filter is called an Infinite Impulse
Response filter or IIR filter. The infinite impulse response of such a filter implies the
ability of the filter to have an infinite impulse response. This indicates that the system
is prone to feedback and instability.
The experiment studies two different types of IIR filters Butterworth Filter, and
Chebyschev I type Filters.
IIR filters are designed essentially by the Impulse Invariance or the Bilinear
Transformation method.

1) Impulse Invariance

This procedure involves choosing the response of the digital filter as an equi-
spaced sampled version of the analog filter.

1. Decide upon the desired frequency response

2. Design an appropriate analogue filter

3. Calculate the impulse response of this analogue filter

4. Sample the analogue filter's impulse response

5. Use the result as the filter coefficients

2) Bilinear Transformation:

The Bilinear Transformation method overcomes the effect of aliasing that is
caused to due the analog frequency response containing components at or beyond the
Nyquist Frequency. The bilinear transform is a method of compressing the infinite,
straight analogue frequency axis to a finite one long enough to wrap around the unit
circle once only. This is also sometimes called frequency warping. This introduces a
distortion in the frequency. This is undone by pre-warping the critical frequencies of
the analog filter (cut-off frequency, center frequency) such that when the analog filter
is transformed into the digital filter, the designed digital filter will meet the desired
specifications.
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Filter Types

Butterworth Filters

Butterworth filters are causal in nature and of various orders, the lowest order
being the best (shortest) in the time domain, and the higher orders being better in the
frequency domain. Butterworth or maximally flat filters have a monotonic amplitude
frequency response which is maximally flat at zero frequency response and the
amplitude frequency response decreases logarithmically with increasing frequency.
A Butterworth filter is characterized by its magnitude frequency response,

[ H(jQ)——

1
Q 2
1+ (=)™
Where N is the order of the filter and Qc is defined as the cutoff frequency where the
filter magnitude is 1/72 times the dc gain (Q=0).

Chebysheyv Filters

Chebyshev filters are equiripple in either the passband or stopband. Hence the
magnitude response oscillates between the permitted minimum and maximum values
in the band a number of times depending upon the order of filters. There are two types
of chebyshev filters. The chebyshev I filter is equiripple in passband and monotonic in
the stopband, where as chebyshev Il is just the opposite.
The Chebyshev low-pass filter has a magnitude response given by

H(jQ) = (1+52T]§(Q£)J

where € is a parameter related to the ripple present in the passband
Tn(x) is given by

c cos(N cos™' x) for | x|< 1, passband
X)=
N cos(N cosh™ x) for | x |<1, stopband

The magnitude response has equiripple pass band and maximally flat stop band. By
increasing the filter order N, the Chebyshev response approximates the ideal response.
The phase response of the Chebyshev filter is more non-linear than the Butter worth
filter for a given filter length N.

Algorithm:

1) Enter the pass band ripple (rp) and stop band ripple (rs).
2) Enter the pass band frequency (wp) and stop band frequency (ws).
3) Get the sampling frequency (fs).
4) Calculate normalized pass band frequency, and normalized stop band frequency w1
and w2 respectively.

wl=2*wp/fs

w2 =2 *ws/fs
5) Make use of the following function to calculate order of filter

Butterworth filter order
[n,wn]=buttord(w1,w2,1p,rs)
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Chebyshev filter order
[n,wn]=cheblord(w1,w2,rp,rs)
6) Design an nth order digital lowpass Butterworth or Chebyshev filter using the
following statements.
Butterworth filter
[b, a]=butter (n, wn)
Chebyshev filter
[b,a]=cheby1(n,0.5,wn)
OR
Design an nth order digital high pass Butterworth or Chebyshev filter using the
following statement.
Butterworth filter
[b,a]=butter (n, wn, high’)
Chebysheyv filter
[b,a]=chebyl (n, 0.5, wn,'high")

7) Find the digital frequency response of the filter by using ‘freqz( )’ function
[H,w]=freqz(b,a,512,fs)
8) Calculate the magnitude of the frequency response in decibels (dB)
mag=20*log10 (abs (H))
9) Plot the magnitude response [magnitude in dB Vs normalized frequency (Hz]]
10) Calculate the phase response using an = angle (H)
11) Plot the phase response [phase in radians Vs normalized frequency (Hz)].

Program:

% IIR filters
clc; clear all; close all;
warning off;
disp('enter the IIR filter design specifications');
rp=input('enter the passband ripple') ;
rs=input('enter the stopband ripple') ;
wp=input('enter the passband freq');
ws=input('enter the stopband freq');
fs=input('enter the sampling freq');
wl=2*wp/fs;%normalized pass band frequency
w2=2*ws/fs;%normalized stop band frequency
[n,wn]=buttord(wl,w2,rp,rs) ;% Find the order n and cut-
off frequency
ch=input('give type of filter 1:LPF,2:HPF');
switch ch
case 1

disp('Frequency response of Butterworth IIR LPF is:');
[b,a]l]=butter(n,wn); % Find the filter coefficient of LPF
[H,w]=freqz (b,a,512,£fs) ;% to get the transfer function
of the filter

mag=20*1o0gl0 (abs (H)) ;

phase=angle (H) ;

subplot(211) ;

plot(w,mag) ;grid on;

ylabel (' --> Magnitude in dB');

xlabel ('--> Normalized frequency in Hz');
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title('Magnitude Response of the desired Butterworh
LPF') ;

subplot(212) ;

plot (w,phase) ;grid on;

ylabel ('--> Phase in radians');

xlabel ('--> Normalized frequency in Hz');

title('Phase Response of the desired Butterworh LPF') ;
case 2

disp('Frequency response of IIR Butterworth HPF is:');
[b,a]l=butter(n,wn, 'high'); % Find the filter co-
efficients of HPF

[H,w]l=freqz (b,a,512,£fs) ;% to get the transfer function
of the filter

mag=20*1ogl0 (abs (H)) ;

phase=angle (H) ;

subplot(211) ;

plot(w,mag) ;grid on;

ylabel ('--> Magnitude in dB');

xlabel ('--> Normalized frequency in Hz');
title('Magnitude Response of the desired Butterworh
HPF') ;

subplot(212) ;

plot(w,phase) ;grid on;

ylabel ('--> Phase in radians');

xlabel ('--> Normalized frequency in Hz');

title('Phase Response of the desired Butterworh HPF') ;
end

Results:

enter the IIR filter design specifications
enter the passband ripple 0.15

enter the stopband ripple 60

enter the passband freq 1500
enter the stopband freq 3000
enter the sampling freq 7000
give type of filter 1:LPF,2:HPF

1

Frequency response of Butterworth IIR LPF is:

29




Digital Signal Processing

--> Magnitude in dB
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IIR HIGH PASS FILTER

IIR filter design specifications
passband ripple 0.15
stopband ripple 60
passband freq 1500

stopband freq 3000
sampling freq 7000
of filter 1:LPF,2:HPF

response of Butterworth IIR HPF is:

Magnitude Response of the desired Butterworh HPF
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$To design a Chebyshev (Type-I) Low/High Pass Filter for the
given specifications

clc; clear all; close all;

disp('enter the IIR filter design specifications');
rp=input('enter the passband ripple');

rs=input('enter the stopband ripple');

wp=input ('enter the passband freq');

ws=input ('enter the stopband freq');

fs=input('enter the sampling freq');

wl=2*wp/fs;%to get normalized pass band frequency
w2=2*ws/fs;% to get normalized stop band frequency

ch=input('give type of filter 1:LPF,2:HPF');

% to get the order and cut-off frequency of the filter
[n,wn]=cheblord (wl,w2,rp,rs);

switch ch

case 1

disp('Frequency response of Chebyshev IIR LPF is:');
[b,a]=chebyl(n,0.5,wn) ;% to get the filter coefficients
% to get the transfer function of the filter
[H,w]=freqz (b,a,512,£fs) ;
mag=20*1oglO0 (abs (H) ) ;
phase=angle (H) ;
subplot (211) ;
plot(w,mag) ;grid on;
ylabel ('--> Magnitude in dB');
xlabel ('--> Normalized frequency in Hz');
title('Magnitude Response of the desired Chebyshev Type -I)
LPF') ;
subplot (212) ;
plot (w,phase) ;grid on;
ylabel ('--> Phase in radians');
xlabel ('--> Normalized frequency in Hz');
title('Phase Response of the desired Chebyshev (Type-I)LPF') ;
case 2
disp('Frequency response of Chebyshev IIR HPF is:');
% to get the filter coefficients
[b,a]=chebyl(n,0.5,wn, '"high') ;
% to get the transfer function of the filter
[H,w]=freqz (b,a,512,fs);
mag=20*1oglO0 (abs (H) ) ;
phase=angle (H) ;
subplot(211) ;
plot(w,mag) ;grid on;
ylabel ('--> Magnitude in dB');
xlabel ('--> Normalized frequency in Hz');
title('Magnitude Response of the desired Chebyshev (Type-
I)HPF');
subplot (212) ;
plot (w,phase) ;grid on;
ylabel ('--> Phase in radians');

xlabel ('--> Normalized frequency in Hz');
title('Phase Response of the desired Chebyshev (Type-I)HPF') ;
end
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Results:

enter the IIR filter design specifications
enter the passband ripple 0.15

enter the stopband ripple 60

enter the passband freq 1500

enter the stopband freq 3000

enter the sampling freq 7000

give type of filter 1:LPF,2:HPF

1

Frequency response of Chebyshev IIR LPF is:

Magnitude Response of the desired Chebyshev(Type-l)LPF
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High Pass Filter
Result:
enter the IIR filter design specifications
enter the passband ripple 0.15
enter the stopband ripple 60
enter the passband freq 1500
enter the stopband freq 3000
enter the sampling freq 7000
give type of filter 1:LPF,2:HPF

2
Frequency response of Chebyshev IIR HPF is:
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Magnitude Response of the desired Chebyshev{Type-I) HPF
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Discussions on results:
By this experiment we have studied the LP/HP IIR digital filter designing.
From the obtained results the students will be able to

1) Discuss the effect of order of the filer on magnitude response.

2) Discuss the effect of variation in pass band ripple, stop band ripple, pass band
frequency, stop band frequency and sampling frequency respectively in
designing the IIR Butterworth digital filter.

3) Discuss the effect of variation in pass band ripple, stop band ripple, pass band
frequency, stop band frequency and sampling frequency respectively in
designing the IIR Chebyshev digital filter.
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Experiment — 6

Aim: - Design and implementation of FIR Filter (LP/HP) to meet given specifications
Using Windowing technique

a. Rectangular window

b. Hamming window

c. Kaiser window

Apparatus: Matlab Software, PC

Theory:

A linear-phase is required throughout the passband of the filter to preserve the
shape of the given signal in the passband. A causal IIR filter cannot give linear-phase
characteristics and only special types of FIR filters that exhibit center symmetry in its
impulse response give the linear-space. A Finite Impulse Response (FIR) filter is a
discrete linear time-invariant system whose output is based on the weighted
summation of a finite number of past inputs.

A zero-phase frequency response of an ideal filter is given as

' 1,|a)| fw,,
H, ,(e")=

0,0.<w<m.
Hence time domain impulse response is

1 7 o\ o sin(@ k)
hd[k]z_ Hd(ej )ej kda)z..:aTk

so the impulse response is doubly infinite, not absolutely summable, and therefore
unrealizable.

By setting all impulse response coefficient outside the range —M <n<M

equal to zero, we arrival at a finite-length noncausal approximation of length ;y =27 + 1
which when shifted to the right yield the coefficients of a causal FIR lowpass filter:

sin(w,(n—M))
hyp[n]= r(n—-M) ,0sn<N-1
0,otherwise

Gibbs phenomenon

The causal FIR filter obtained by simply truncating the impulse response coefficients
of the ideal filters exhibit an oscillatory behavior in their respective magnitude
responses which is more commonly referred to as the Gibbs phenomenon

Cause of Gibbs phenomenon:

The FIR filter obtained by truncation can be expressed as

h[n]= h,[n]- o[n]

H(ejw) =LJ‘” Hd (e'/¢)y/(e"(”’¢))d¢
27 -
The window used to achieve simple truncation of the ideal filter is rectangular

window
LO<|n|<M
WR[}’I] =

0, otherwise
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Thus by applying windowing functions we can obtain FIR filters.

Available Fixed window functions Rectangular, Bartlett, Hamming, Hanning,
Blackmann etc.

Hamming window function

27xn
2M +1

In Adjustable Window Functions, windows have been developed that provide control
over ripple by means of an additional parameter.
Like Kaiser Window

w[n] = 0.54 +0.46 cos(

),—M <n<M

10<ﬁ 1—(n/M)2}

win] = (A

~—M<n<M

Where £ is an adjustable parameter and /,(f) is a zero order Bessel function

To design a FIR filter order of the filter should be specified or can be calculated from
the following equation

—20log,, ( 7,7, )—13
N =
14.6(w, - w, ) /27
rp=passband ripple, rs=stopband ripple, wp=passband frequency
ws=stopband frequency
Then from order of the filter we can find the length by which a window function can
be applied.

Algorithm:
FIR Low Pass Filter design

1) Enter the pass band ripple (rp) and stop band ripple (rs).
2) Enter the pass band frequency (wp) and stop band frequency (ws).
3) Get the sampling frequency (fs), beta value for Kaiser window.
4) Calculate the analog pass band edge frequencies, wl and w2.
i. wl =2*wp/fs
. w2 =2%*ws/fs
5) Calculate the order of the filter using the order equation.
6) Use switch condition and ask the user to choose either Rectangular Window or
Hamming window or Kaiser window.

7) Use rectwin, hamming, Kaiser Commands
Command firl uses the window method of FIR filter design, If w(n)
denotes a window, where 1 < n < N, and the impulse response of the ideal
filter is h(n), where hg(n) is the inverse Fourier transform of the ideal
frequency response.

h{n] = h,[n]-o[n]
8) Calculate the digital frequency response using the command ‘freqz()’
9) Calculate the magnitude of the frequency response in decibels
m=20*log10 (abs(h))

10) Plot the magnitude response [magnitude in dB Vs normalized frequency

(om/pi)]
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Program:

$FIR Low Pass/High pass filter design using
Rectangular/Hamming/Kaiser window
clc; clear all; close all;
rp=input ('enter passband ripple');
rs=input('enter the stopband ripple');
wp=input ('enter passband freq');
ws=input ('enter stopband freq');
fs=input('enter sampling freq ');
beta=input ('enter beta wvalue');
wl=2*wp/fs;
w2=2*ws/fs;
num=-20*1o0gl0 (sqrt (rp*rs))-13;
dem=14.6* (ws-wp) /£fs;
n=ceil (num/dem) ;
nl=n+l;
if(rem(n,2)~=0)

nl=n; n=n-1;
end
c=input('enter your choice of window function 1. rectangular
2. Hamming 3.kaiser: \n ');
if (c==1)

y=rectwin (nl) ;

disp ('Rectangular window filter response');
end
if (c==2)

y=hamming (nl) ;

disp ('Hamming window filter response');
end
if (c==3)

y=kaiser (nl,beta) ;

disp('kaiser window filter response');
end

ch=input('give type of filter 1:LPF,2:HPF');
switch ch
case 1

b=firl(n,wl,y)

[h,o]=freqz (b,1,256) ;

m=20%*1ogl0 (abs (h)) ;

plot (O/Pl ,m) ;

title('LPEF") ;

xlabel (' (a) Normalized frequency-->');

ylabel ('Gain in dB-->');

case 2
b=firl(n,wl, 'high',y);
[h,o]=freqz (b,1,256) ;
m=20%*1ogl0 (abs (h)) ;
plot(o/pi,m);
title('HPF') ;
xlabel (' (b) Normalized frequency-->');
ylabel('Gain in dB-->');
end

Results:
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enter passband ripple 0.02
enter the stopband ripple 0.01
enter passband freq 1000
enter stopband freq 1500
enter sampling freq 10000
enter beta value 5

enter your choice of window function 1. rectangular 2.
Hamming 3.kaiser:

1
Rectangular window filter response
give type of filter 1:LPF,2:HPF
1:LPF

Low pass FIR filter using Rectangular Window

LRE:

Gain in dB-->
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(a) Normalized frequency-->

enter your choice of window function 1. rectangular 2.
Hamming 3.kaiser:
2
Hamming window filter response
give type of filter 1:LPF,2:HPF
1:LPF
Low pass FIR filter using Hamming Window
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enter your choice of window function 1.
Hamming 3.kaiser:
3
kaiser window filter response
give type of filter 1:LPF,2:HPF

1:LPF
Low pass FIR filter using Kaiser Window
LPF
20 : . : : : . T : .
0 -4
20k 4
& -40 _
£ e} -
o
80 F 4
100 f -
_120 1 1 1 1 1 1 1 1 1
0 01 02 03 04 05 06 07 08 09 1
{a) Normalized frequency-->
FIR High pass Filter design
Results:
enter passband ripple 0.02
enter the stopband ripple 0.01
enter passband freq 1000
enter stopband freq 1500
enter sampling freq 10000
enter beta value 5
enter your choice of window function 1. rectangular 2.

Hamming 3.kaiser:
1
Rectangular window filter response
give type of filter 1:LPF,2:HPF
2 :HPF
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High pass FIR filter using Rectangular Window

HPF

ot /\
20+

-30 P

Gain in dB-->

-40 F

50 F

60 ' 1 1 L L L L 1
o 0.1 0.2 0.3 0.4 05 0.6 0.7 0.8

(b) Normalized frequency-->

enter your choice of window function 1.
Hamming 3.kaiser:

2

Hamming window filter response

give type of filter 1:LPF,2:HPF

2 :HPF

09 1

rectangular 2.

High pass FIR filter using Hamming Window

HPF
20 ;

Ao

A0 ¢

Gain in dB-->

-B0 F

80 F

_100 1 1 1 1 1 1 L 1
0 0.1 02 03 0.4 05 06 07 08

(b) Normalized frequency-->

enter your choice of window function 1.
Hamming 3.kaiser:

3

kaiser window filter response

give type of filter 1:LPF,2:HPF

2: HPF

09 1

rectangular 2.
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High pass FIR filter using Kaiser Window

10 T T T T

Gain in dB-->
N
o

1 1 1 1

0 0.1 02 03 04

05 06 07 08

{b) Normalized frequency-->

Discussions on results:

Thus FIR digital filter designing is experimented using Matlab software.

Thus from the results students will be able to

1) Discuss the effect of order of the filer on magnitude response.

Lab Manual

2) Discuss the effect of variation in pass band ripple, stop band ripple, pass band
frequency, stop band frequency and sampling frequency respectively in

designing the FIR digital filter.

3) Discuss the difference between the Rectangular, Hamming and Kaiser

Window functions.

4) Discuss the performance of FIR digital filter designed using Kaiser window
over FIR digital filter designed with Rectangular and Hamming window

functions.
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Introduction to TMS320C6713 DSK]| Courtesy: Texas Instrument]

CE¥13 DSk Board
+5% Universal
Power Supply

CE713 05K Code
Compozer Studio CD

THWS320CE713 DSk
Technical Reference

USE Cable

The C6713™ DSK builds on TI's industry-leading line of low cost, easy-to-use DSP
Starter Kit (DSK) development boards. The high-performance board features the
TMS320C6713 floating-point DSP. Capable of performing 1350 million floating-
point operations per second (MFLOPS), the C6713 DSP makes the C6713 DSK the
most powerful DSK development board.

The DSK is USB port interfaced platform that allows to efficiently develop and test
applications for the C6713. The DSK consists of a C6713-based printed circuit board
that will serve as a hardware reference design for TI’s customers’ products. With
extensive host PC and target DSP software support, including bundled TI tools, the
DSK provides ease-of-use and capabilities that are attractive to DSP engineers.

The following checklist details items that are shipped with the C6711 DSK Kkit.

» TMS320C6713 DSK TMS320C6713 DSK development board

» Other hardware External 5VDC power supply

IEEE 1284 compliant male-to-female cable

» CD-ROM Code Composer Studio DSK tools
The C6713 DSK has a TMS320C6713 DSP onboard that allows full-speed
verification of code with Code Composer Studio. The C6713 DSK provides:

e A USB Interface

e SDRAM and ROM
e An analog interface circuit for Data conversion (AIC)

e An /O port
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e Embedded JTAG emulation support

Connectors on the C6713 DSK provide DSP external memory interface (EMIF) and

peripheral signals that enable its functionality to be expanded with custom or third

party daughter boards.

The DSK provides a C6713 hardware reference design that can assist you in the
development of your own C6713-based products. In addition to providing a reference
for interfacing the DSP to various types of memories and peripherals, the design also
addresses power, clock, JTAG, and parallel peripheral interfaces.

The C6713 DSK includes a stereo codec. This analog interface circuit (AIC) has the
following characteristics:

High-Performance Stereo Codec

e 90-dB SNR Multibit Sigma-Delta ADC (A-weighted at 48 kHz)

e 100-dB SNR Multibit Sigma-Delta DAC (A-weighted at 48 kHz)

e 1.42V-3.6V Core Digital Supply: Compatible With TI C54x DSP
Core Voltages

e 2.7V -3.6V Buffer and Analog Supply: Compatible Both TI C54x
DSP Buffer Voltages

e 8-kHz —96-kHz Sampling-Frequency Support

Software Control Via TI McBSP-Compatible Multiprotocol Serial Port
e 12 C-Compatible and SPI-Compatible Serial-Port Protocols
o Glueless Interface to TI McBSPs
[ ]
Audio-Data Input/Output Via TI McBSP-Compatible Programmable Audio Interface
e 12 S-Compatible Interface Requiring Only One McBSP for both ADC
and DAC
e StandardI 2 S, MSB, or LSB Justified-Data Transfers
16/20/24/32-Bit Word Lengths

The C6713DSK has the following features:

The 6713 DSK is a low-cost standalone development platform that enables customers
to evaluate and develop applications for the TI C67XX DSP family. The DSK also
serves as a hardware reference design for the TMS320C6713 DSP. Schematics, logic
equations and application notes are available to ease hardware development and
reduce time to market.

The DSK uses the 32-bit EMIF for the SDRAM (CEO) and daughtercard expansion
interface (CE2 and CE3). The Flash is attached to CE1 of the EMIF in 8-bit mode.

An on-board AIC23 codec allows the DSP to transmit and receive analog signals.
McBSPO is used for the codec control interface and McBSP1 is used for data. Analog
audio I/O is done through four 3.5mm audio jacks that correspond to microphone
input, line input, line output and headphone output. The codec can select the
microphone or the line input as the active input. The analog output is driven to both
the line out (fixed gain) and headphone (adjustable gain) connectors. McBSP1 can be
re-routed to the expansion connectors in software.

A programmable logic device called a CPLD is used to implement glue logic that ties
the board components together. The CPLD has a register based user interface that lets
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the user configure the board by reading and writing to the CPLD registers. The
registers reside at the midpoint of CE1.

The DSK includes 4 LEDs and 4 DIP switches as a simple way to provide the user
with interactive feedback. Both are accessed by reading and writing to the CPLD
registers.

An included 5V external power supply is used to power the board. On-board voltage
regulators provide the 1.26V DSP core voltage, 3.3V digital and 3.3V analog
voltages. A voltage supervisor monitors the internally generated voltage, and will
hold the board in reset until the supplies are within operating specifications and the
reset button is released. If desired, JP1 and JP2 can be used as power test points for
the core and I/O power supplies.

Code Composer communicates with the DSK through an embedded JTAG emulator
with a USB host interface. The DSK can also be used with an external emulator
through the external JTAG connector.

TMS320C6713 DSP Features

< Highest-Performance Floating-Point Digital Signal Processor (DSP):
> Eight 32-Bit Instructions/Cycle
32/64-Bit Data Word
300-, 225-, 200-MHz (GDP), and 225-, 200-, 167-MHz (PYP) Clock Rates
3.3-,4.4-, 5-, 6-Instruction Cycle Times
2400/1800, 1800/1350, 1600/1200, and 1336/1000 MIPS /MFLOPS
Rich Peripheral Set, Optimized for Audio
Highly Optimized C/C++ Compiler
Extended Temperature Devices Available
< Advanced Very Long Instruction Word (VLIW) TMS320C67x™ DSP Core
> Eight Independent Functional Units:
= Two ALUs (Fixed-Point)
= Four ALUs (Floating- and Fixed-Point)
= Two Multipliers (Floating- and Fixed-Point)
Load-Store Architecture With 32 32-Bit General-Purpose Registers
Instruction Packing Reduces Code Size
All Instructions Conditional
< Instruction Set Features
Native Instructions for IEEE 754
= Single- and Double-Precision
> Byte-Addressable (8-, 16-, 32-Bit Data)
> 8-Bit Overflow Protection
> Saturation; Bit-Field Extract, Set, Clear; Bit-Counting; Normalization
< L1/L2 Memory Architecture
> 4K-Byte L1P Program Cache (Direct-Mapped)
> 4K-Byte L1D Data Cache (2-Way)

YV V V V V V

A\

Y V V

A\
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o
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> 256K-Byte L2 Memory Total: 64K-Byte L2 Unified Cache/Mapped RAM,

and 192K-Byte Additional L2 Mapped RAM
Device Configuration
> Boot Mode: HPI, 8-, 16-, 32-Bit ROM Boot
> Endianness: Little Endian, Big Endian
32-Bit External Memory Interface (EMIF)
> Glueless Interface to SRAM, EPROM, Flash, SBSRAM, and SDRAM
> 512M-Byte Total Addressable External Memory Space
Enhanced Direct-Memory-Access (EDMA) Controller (16 Independent Channels)
16-Bit Host-Port Interface (HPI)
Two Multichannel Audio Serial Ports (McASPs)
> Two Independent Clock Zones Each (1 TX and 1 RX)
> Eight Serial Data Pins Per Port:

Individually Assignable to any of the Clock Zones
> Each Clock Zone Includes:
* Programmable Clock Generator
= Programmable Frame Sync Generator
= TDM Streams From 2-32 Time Slots
= Support for Slot Size:
8, 12, 16, 20, 24, 28, 32 Bits

= Data Formatter for Bit Manipulation
Wide Variety of 12S and Similar Bit Stream Formats
> Integrated Digital Audio Interface Transmitter (DIT) Supports:

= S/PDIF, IEC60958-1, AES-3, CP-430 Formats

= Up to 16 transmit pins

» Enhanced Channel Status/User Data
> Extensive Error Checking and Recovery
Two Inter-Integrated Circuit Bus (I12C Bus™) Multi-Master and Slave Interfaces
Two Multichannel Buffered Serial Ports:
> Serial-Peripheral-Interface (SPI)
> High-Speed TDM Interface
> AC97 Interface
Two 32-Bit General-Purpose Timers
Dedicated GPIO Module With 16 pins (External Interrupt Capable)
Flexible Phase-Locked-Loop (PLL) Based Clock Generator Module
IEEE-1149.1 (JTAG 1) Boundary-Scan-Compatible
Package Options:
> 208-Pin PowerPAD™ Plastic (Low-Profile) Quad Flatpack (PYP)
> 272-BGA Packages (GDP and ZDP)
0.13-pm/6-Level Copper Metal Process
» CMOS Technology

3.3-V 1/Os, 1.2 ¥ -V Internal (GDP & PYP)
3.3-V I/Os, 1.4-V Internal (GDP)(300 MHz only)
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LINE OUT

- Memory Exp

£
= e
O
..... o
; ]
. :IO:
Voltage : .
Reg : : o
Embedded : : :
: ' =t Peripheral Ex
- JTAG FECPE eripheral Exp
g -1 T — R :
v ol [Bx | [EEEe [ Coeg
= @l | JTAG g 0123 0123

TMS320C6713 DSK Overview Block Diagram [Courtesy: Texas Instrument]

Line In Headphone
Line Out |

Mic In

" /AIC23,Codec
v -' E. i‘a #
“pr TMS320C .

6713
DSP

'Host Port Interface

Peripheral Eg(pansion

1
Power USB DIP LEDs Reset Config External Hurricane
Jack Port Switches Switch Switch JTAG Header

Procedure to work with CCS-V5 using TMS320C6713
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Procedure to work with non real time program (Linear Convolution)

Stepl: Creation of a Target configuration

Lab Manual

File->new->target configuration , you will get window as shown in figl. You
can give any target name with extension .ccxml (for example here I have taken target

name as 6713.ccxml) after giving the name click on finish.

S New Target Configuration

Target Configuration
Create a new Target Configuration file.

File name: | 6713.ccxml
Use shared location

Location: | C:fDocuments and SettingsjAjaruddeen.pyatifti/CCSTargetConfigurations

- | BX

@ (

Finish

Cancel ]

Once you click on finish you will get general setup window as shown below in fig2.
In the general setup you have select device and connection as mentioned below.

Connection
Board or Device: TMS320C6713
Then click on SAVE

X, *6713.ccxml 32
Basic

General Setup
This section describes the general configuration about the target.

Connection

I -
<ISpectrum Digital DSK-E¥M-eZdsp onboard USB Emulator
ce [ g7

Board or D

[] oske713
[] TMms320Cce6711
[] TMms320Cce712

TMS320F 2506

C67x Floating-point DSP

Mote: Support For more devices may be available from the update manager.

: Spectrum Digital DSK-EVM-eZdsp onboard USB Emulator

= 8

Advanced Set

Target Configu

Save Configur
Gl >

Test Connecti

To test a conne
configuration Fil
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Step 2: Launch the Target Configuration
Go to view from toolbar
View—> target configuration , you can see your target name under user defined
as circled in fig 3 .
Here under user defined it is showing 6713.ccxml it is my target.

gate Project Run Scripts Window Help

s~ &~ == Y | B €Cs Edit
- % ¥ = 0| %5 pebug 2 > ¥ =0
% 6713.coxml 52 = O || ) Target Configura... 3 = O
Basic 2 BX $E
General Setup Advanced Set

This section describes the general configuration about the target. =5 Projects

- | SR=. fi
Connection Spectrum Digital DSK-EVM-eZdsp onboard USB Emulator v Target Confiqu & User Defined
[ 6713.ccxml [Default
Board or Device [g7
Save Configur =

[J psk6713

[] Tms320C6711
[] TmMs320C6712
TMS320C6713

Test C tie
[J TmMs320F28067 est Connecti

To test a conne < >
configuration Fili
Click the New button to create a new

< e target configuration file. Click here.
Basic | Advanced Source to hide this message.
[2¢ Problems 52 = el

Right click on your target(6713.ccxml), then launch selected configuration as shown
in figd below.

& 6713.coxml 22 = B | 2 Target Configura..
. ~
3asic 14|
General Setup Advanced Set
This section describes the general configuration about the target. =% Projects
o | 3 8= fi
Connection Spectrum Digital DSK-EYM-eZdsp onboard USB Emulator v Target Configu & Useﬂ
Board or Device [ g7 1 ‘ %, New Target Configuration
- B Import Target Configuration
[] pske713
[] TMs320C6711 ¥ Delete Delete
[] TmMs320C6712 Rename F2

TMS320C6713

& Refresh FS
[[] TMS320F28067 ¥

& Launch Selected Configuration

Set as Default
asic | Advanced  Source Link File To Project

. Problems &3 Properties Alt+Ente

items
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Step 3: Connecting the target
go to Run—>connect target as shown in below.

fit Vview Project Tools ms-:ripts Window Help

Com -
A~ = _Connect Target Ctri+alt+C

ug 22 X : bles £2 | 64 Expressions | 53§ R
| 6713.ccxml [Code Compos @3 Load 4 Type
Spectrum Digital DSK-E

Terminate Ctrl+F2
@ Reset >
3.cexml £2
ic
eral Setup _A Advanced Setup
: section describes the gene
wnection Soectrum Did Target Configuration: lists the

Note: on mail CCS window there are two prospective are there one is CCS Debug and
one more is CCS edit . as shown in below diagram fig 6 . in CCS debug it contain all
option related to target and in CCS edit it contain all options related to projects(
source, lib etc)

s - 5~ 5 | ¥4 CCS Debug
- @> ¥ = O | 069= variables 2 | 65 Expressions | 513! Registers <t 3 \&2 BS CCS Edit
:bugging] Name Type Value

JSB Emulator_0jTMS320C671X (Discol

>
Advanced Setup
ut the target.
ynboard USB Emulator ~ Target Configuration: lists the configuration options for the target.

Save Configuration
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Step 4: Creation of a project
First click on CCS edit as shown below

oW  rep
A A
@&~ & @ ¥ T 0O - variables 52 |67 Expressions | %! Registers
bugging] Name Type

SB Emulator_0/TMS320C671X (Discol

Lab Manual

[ | 55 CCS Debug |

Value Location

Then go to File>new—>CCS Project as shown in below figure.

& CCS Edit - C:\Documents and Settings\Ajaruddeen. pyati\ti\CCSTargetConfigurations\6713.ccxml
W Edit View Mavigate Project Run Scripts Window Help

New Ale+Shife+N > i CCS Project
Open File... [ Project...
Close Cerl+w ¢/ Source File
Close all Ctrl+Shift+W h' Header File
I & Class
&), save As... | % File from Template jet.
("% Folder B Emula
¥, Target Configuration File
& C6Flo Diagram
7 |2¥ DSPYBIOS vS.x Configuration File
) : |& RTSC Configuration File
Convert Line Delimiters To » [ Other... Ctrl+N
Switch Workspace 4
Restart
229 Import...

Then make as changes as mentioned.

Project name: any name (for example I have given as linear)

Family : C6000

Variant : C671xFloating-point DSP TMS320C6713

Connection : Spectrum Digital DSK-EVM-eZdsp onboard USB Emulator

Then select empty project, Then click on finish .
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CCS Project S35
7§ Create a new CCS Project. Ej

Project namé:]iﬂf@f__

Output type: v Executable v | S

Use default location

{

Device

Family:

| CB71x Floating-point DSP v/ 'TMS320C6713

ctrum Digital DSK-EVM-eZdsp onboard USB Emulator

» Advanced settings

Yariant:

Connection:

w Project templates and examples

Creates an empty project fully initialized For
the selected device.

i

Empty Projects ~

£ Empty Project {with main.c)
[ Empty Assembly-only Project
[ Empty RTSC Project

| Basic Examples

5 Hello World

C6Flo Examples | =

10 and 1IN Fvamnlac

@ - Next [ Finish  J [ cancel ]
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Step 5: Create a source file

File>new-> source file
Source file: give any name with extension .c(here I have given as lin.c) as sown in
Then click on finish.

- -

Project Explorer 22 = ir, Y = 0| R = -
s . & New Source File - @
= linear [Active - Debug]
# ) Includes Source File
@ g C6713.cmd Create a new source file. C Set
% TMS320C6713.coxml [Active]
i ) fiqu
Source folder: | linear |
Source file: lin.c| gur
Template: :Default C++ source template v
lecti
bnne
pn fils
2
Ba)
24 @ Finish l [ Cancel ]
0 it
Fig 10

Now write a code on workspace, then go to file>save.

Step 6: Build the project
Go to Project->Build Project as shown in Fig 1 1below.

View Navigate NZ9E8 Run Scripts Window Help

L [0 New CCS Project

CCS Example Projects
Explorer 22 20C6713.coxml
Active _p  wBuid Al Ctrl+8
ear [Active - Build Configurations >
Includes . ;
C6713.cmd Build Project
' .cm
: Build Working Set > L
| lin.c Jun 19, 2
Clean...
TMS320C6713.c ajaruddee

Build Automatically
Show Build Settings...

nent linea

>
=9 Import Existing CCS Eclipse Project

20 Import Legacy CCSv3.3 Project

Properties
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Step 7: run the project

Switch to CCS debug prospective as shown in below figure.

£ | B CCsEdit

= 8| 7 Ks CCS Debug

A

1:4

=I\=* Projects
=125 linear
T, TMS:
=l (> User Defined
T, 6713.cc

Then go to Run—>Resume to run the program.

You can see output of linear convoluted samples as in watch window by typing in
expression as mention below.

View—>expression

Then type output variable name y then enter as shown below.

=, 2% @ - & -

G’ Expressions 3 =8
E B RRP 92T

Expression Type Value

# Sy int[20] 0x00009430

¢ Addnew ex

Step 8: Plotting a graph

Go to Tools>Graph—>Single Time , then make graphical properties change as per
program here in figl4 I had made changes which round up with red line . this changes
applicable for linear convolution program. Then click ok.
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B Graph Properties

Property Value
=l Data Properties
‘nes Wﬁﬁ_lx\
)sp Data Type 32 bit signed integer ___-
Index Increment————+——————
_Value o
Sampling Rate Hz 1
StartAddress v
=l Display Properties
Axis Display ] true
Data Plot Style Line
isplay Data Size 1
Grid Style No Grid
Magnitude Display Scale Linear
Time Display Unit sample
Use Dc Yalue For Graph ] False

Co)

In following figure my expected graph for linear con is displayed.

2< Single Time -2 &3
78 -
74

70

6z ]
se -
54
so -]
a6 |
4z
38 ]
34 ]
30
26 -]

22
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18 -
14
10 -

Procedure to work with real time program(FIR)
Note: Here again no need to create a new target configuration because we can use the
same so now directly I will go to creating a project

Step 1: Create a Project

N

Please refer the step 4 of non real time program, give the project name as FIR.

Step 2: Create a source file

Please refer the step 5 of non real time program , give the source file name as FIR.C.

Step 3: Adding library file

Go to project—>add files as shown in below figure.
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MNavigate Run Scripts Window Help

R - [T New CCS Project
CCS Example Projects
w3
019 Build All Ctrl+B
m Build Configurations » Read a san
Build Project le (!'DSK67
:zm 3 Build Working Set »
Clean... Read a san
OCET13. Build Automatically le (!DSK67
: Show Build Settings...
o
r_output=
29 Import Existing CCS Eclipse Project
59 Import Legacy CCSv3.3 Project pend a san
le (!'DSK67
Properties

/% Send a san

while (!DSK67

lj[l QX

Then you have to add bsl and csl library files. These files you will get in below
mentioned paths.

e BSL(Board support library file)

Path : C:\CCStudio_v3.1\C6000\dsk6713\lib\dsk6713bsl.lib
e CSL(Chip support library file )

Path: C:\CCStudio v3.1\C6000\csI\lib\cs16713.lib
You can see these files added to your project as shown below in figure.

File Edit Yiew MNavigate Project Run Script:

H H H 4
: &' : %" e A0
[ Project Explorer 53 ag® Y =0
— )
®B-§5= F
Workspace
CRr= I._- - Debug]
&) Includes

# | % C6713.cmd
+ fir.c
B, csl6713.lib
%) TMS320C6713.coxml [Active]
= linear

Lab Manual
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Step 4: Setting Build properties
Go to project—>properties , under Build—> C6000 Compiler—>include options now
click on add as shown in below figure

¥ Properties for fir1 - [B][X]

-

Include Options =1 v

# Resource
General - -
(= Build Configuration: kDebug [ Active ] v

(=) C6000 Compiler
Basic Options
Symbolic Debug Options
Language Options
Parser Preprocessing Options
Predefined Symbols
Diagnostic Options
Runtime Model Options
Optimizations
Entry/Exit Hook Options
Feedback Options
Library Function Assumptions
Assembler Options
File Type Specifier
Directory Specifier
Default File Extensions
Dynanmic Linking Support Options
Command Files
MISRA-C:2004

# C6000 Linker
Debug

Specify a preinclude file (--preinclude) &)

Then click on file system and go to this path C:\CCStudio v3.1\C6000\csl\include,
then ok.

Basic Options

Symbolic Debug Options )
Language Options Add dir to #include search path (--include_path, -I) ¢ %)
Parser Preprocessing Options 4 o agl

Predefined Symbols $ Edit directory path
Include Options
Diagnostic Options Directory:
Runtime Model Option| |
Optimizations ‘
Entry/Exit Hook Optiof
Feedback Options
Library Function Assu
Assembler Options [
File Type Specifier
Directory Specifier
Default File Extensions

Nvnamir | inkina Stinnart Ontinne

OK ] [ Cancel ] [Workspace...] [File system...]

Specify a preinclude file (--preinclude) &) %

Now again under same build go to

Build> C6000 Compiler->Predefined symbols , Then again click on add(On top right
side Plus indication in green color symbol ).

Then type As CHIP_6713 then apply ok,
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Predefined Symbols (=1 -

#* Resource
General
= Build Configuration: |Debug [ Active ] ~

=) C6000 Compiler
Basic Options
Symbolic Debug Options
Language Options Pre-define NAME (--define, -D) £ w) 8§
Parser Preprocessing Options.
Predefined Symbols % Edit Dialog
Include Options
Diagnostic Options
Runtime Model Option|
Optimizations
Entry/Exit Hook Optiot
Feedback Options
Library Function Assu
Assembler Options
File Type Specifier
Directory Specifit
Default File Extensions
Dynamic Linking Support Options
Command Files
MISRA-C:2004

# C6000 Linker

Debug

Pre-define NAME (--define, -D)

( [ H Cancel ]

Undefine NAME (—-undefine, -U) €]

<

%

@ Show advanced settings OK ] [ Cancel ]

Step 5: Build the project

Go to Project>Build Project.

Step 6: run the project

Then go to Run—>Resume to run the program.
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I. Procedure to work with NON REAL TIME programs (Linear

Convolution):
NR1: Creation of a project

Go to File>new=>CCS Project as shown in figure below

cexml

% CCS Edit - C:\Documents and Settings\Ajaruddeen. pyati\ti\CCSTargetConfigurations\6713.
70 Edit View Navigate Project Run Scripts Window Help

New Al+Shift+N ¥ | CCS Project

Open File... [ Project...
Close Ctri+w ¢/ Source File
Close Al Ctrl+Shift+w ) Header Fie
(© Class
E save hs... ¥ File from Template
(Y Folder

%, Target Configuration File

Then make changes as mentioned below(or refer the figure in next page):

Project name: any name (for example I have given as linear)
Family : C6000
Variant : <LEAVE IT BLANK> | DSK6713

et

38 Emula

Connection : Spectrum Digital DSK-EVM-eZdsp onboard USB Emulator (if using

the kit)

Advanced settings:

Linker Command file: C:\CCStudio_v3.1\tutorial\dsk6713\hello1\hello.cmd
Runtime Support Library: C:\CCStudio_v3.1\C6000\cgtools\lib\rts6700.1ib

Then select empty project, Then click on finish .
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Project name: [ linear ]

Output type: [ Executable v l

Use default location

Location: | G:\workspace_v5_6_674812\linear Browse...
Device
Family: | C6000 vl
Variant: [ <select or type filter text> v ] {DSK6713 v }
Connection: [Spectrum Digital DSK-EVM-eZdsp onboard USB Emulator V]

v Advanced settings

Device endianness: l little v ‘
Compiler version: l TIv7411 v ] [ More... ]
Output format: [ legacy COFF v ‘

Linker command file: [C:\CCStudio_v3.1\tutorial\dsk6713\hello1\he vH Rl ‘

Runtime support library: | (SN TRERIG N GG v| | Browse.. |

v Project templates and examples

{ type filter text Creates an empty project fully initialized
. for the selected device.
4 = Empty Projects A

[ Empty Project (with main.c)
[ Empty Assembly-only Project
[ Empty RTSC Project
4 [=) Basic Examples
[ Hello World
b IPC and I/0 Examples v

@ < Back Next > Finsh || Cancel
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NR2: Creation of source file (Use either a or b):
a. Create a source file

File->new-> source file

Project Explorer 2 &% Y T08||R N — =
o5 & & New Source File = @@ —
= linear [Active - Debug] Bl —
# ) Includes Source File
# |z C6713.cmd Create a new source file. C Set
¥ TMS320C6713.coxml [Active]
fiqu
Source folder: | linear
Source file: lin.c| )
Template: | Default C++ source template v
e ctii
ne
n Filk
< >
Ba)
e @
0it

Source file: give any name with extension .c (here I have given as lin.c) Then click
on finish.
Now write a code (or copy the lin.c) on workspace, then go to file->save.

/Min.c

#include<stdio.h>

#define LENGHT1 6 /*Lenght of i/p samples sequence®/
#define LENGHT2 4 /*Lenght of impulse response Co-efficients
*/

int x[2*LENGHT1-1]={1,2,3,4,5,6,0,0,0,0,0}; /*Input Signal
Samples™*/

int h[2*LENGHT1-1]={1,2,3,4,0,0,0,0,0,0,0}; /*Impulse
Response Coefficients*/

int yyLENGHT1+LENGHT2-1];

main()

{

int i=0,j;

for(i=0;i<(LENGHT1+LENGHT2-1);i++)

{

y[i]=0;

for(j=0;j<=i;j++)

{[i]+=X[i]*h[i-j];

for(i=0;i<(LENGHT1+LENGHT2-1);i++)
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b. Add existing C file:

Right click on project name and choose Add files..
Now browse the lin.c from the system and click OK.

NR3: Build the project

Go to Project->Build Project as shown below.

View Navigate NZ@SEEE Run Scripts Window Help

: Q = [0 New CCS Project

CCS Example Projects
Explorer 22 20C6713.coxml
[Act o la10 Build All Ctri+B
8 Lactive Build Configurations >
Includes - :
c6713.cmd Build Project
t Lo
. c Build Working Set » ~
| lin.c Jun 19, 2
TMS320C6713.¢ Clean... ajaruddee
) Build Automatically TATE T
Show Build Settings...
ent linea
h>
2 Import Existing CCS Eclipse Project
29 Import Legacy CCSv3.3 Project
Properties
14 { int m=6;
15 int n=6;

If your code doesn’t have any errors and warnings, a message will be printed in the
console window that “**** Build Finished **x*”

Problems window display errors or warnings, if any.

] console &3

= O | [Z! problems 22
CDT Build Console [Hello LCDK]

O items
L oS SBEeEE =2 B -3~ Description
/include” ——reread_ libs ——warn_ sections

——display error_nuwuaber
—xrmal_link info="Hello
LCDEK_linkInfo.xml"” ——rorm model —-o "Hello

LCDK.outc "™ "./Hello.obj™ "../C6748.crd"™
—1"libc.a™
<Linking>

-~
——diag_wrap=off -—

'Finished building target:
LCDK.outc'

Hello

ooy v balel aohhenipare L oy
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NR4. DEBUG

After successful Build, connect the kit with the system using the JTAG emulator and
power the kit.
Click the Debug as shown in the below figure.

File Edit View Navigate Project Run Scripts Window Help
TJ v Q v $ )) v Q \}3 v v
—

(GProjectolorer £21 ][ B 7 1] ] SNEWAVEC

It will redirect to the Debug perspective automatically.

NRS5: Running the project

Wait until the program loaded to the hardware automatically.
Now you can run the code, by selecting Run-> Resume.

Tools Im Scripts  Window Help

: 35|V 5 Connect Target Clri+Alt+C
: Disconnect Target Ctrl+alt+D
. % AL
Code ¢  ({¥Lload 4
nts XD
bllo.c:e] 1™ Resume F8
- boot.(¢

The linear convolution values will be displayed in the Console window.

NRG6: Plotting a graph

Go to Tools>Graph->Single Time , then make graphical properties change as per
program (Graph property will vary according to your program).
These changes are applicable for linear convolution program. Then click ok




Digital Signal Processin Lab Manual

Property Value

4 Data Properties
Acquisition Buffer Size 9
Dsp Data Type 32 bit signed integer
Index Increment 1
Q_Value 0
Sampling Rate Hz 1

| Start Address y

4 Display Properties
Axis Display ] true
Data Plot Style Line
Display Data Size 9
Grid Style No Grid
Magnitude Display Scale Linear
Time Display Unit sample
Use Dc Value For Graph [ false

Expected graph for linear convolution:

22 Single Time -2 =3 | B = = d1 - v - @& Sl R - | S [ST]85 % B | ¢ 3k - G

75
74 ]

70

66 — /
&2 e
ss ]

s

so ]

a6 ]

4z

s8]

24 ]

s0 ] e

26 ] /

22

18

]

o

Terminate the project after use:
JYECt 100IS Kun DCrpts wWinaow Help
1ids~- @B -VRE~ P~

%> (R0

[Code Composer Studio - Device Dﬁq\ugging]

A v arAnAmr—an r

Note: In the same way all the Non Real-Time projects can be done by just replacing the
corresponding source files.
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I1. Procedure for using simulation mode (without the kit and assuming
that you have already created a non-real time project):

e Goto File-> New -> Target Configuration File
[ ]

Target Configuration

Create a new Target Configuration file.

File name: | C6713simulator.coxml

Use shared location

Location: | C:/Users/dinesh.babu/user/CCSTargetConfigurations | File System...  Workspace...

Give a name with ‘.ccxml’ extension.
Connection: Texas Instruments Simulator
Device: <just type 6713>

Choose ‘....little endian’ (see the below figure)

General Setup Advance
This section describes the general configuration about the target.

Connection | Texas Instruments Simulator N Taget
Device 6713 - Save Cor

[[] €6713 Device Cycle Accurate Simulator, Big Endian
I C6713 Device Cycle Accurate Simulator, Little Endian

Save

Test Con

e Click SAVE.
e View-> Target Configurations
e Target Configurations tab will be opened:

%, Target Configurations 3

type filter text

. = Projects
4 (= User Defined
) 28035.coxml
%) 6678.caxml
@ 6713sim.caxml
| %) C6713simulator.coml |
< 11381 CNK.coxml

e Right on your file and click Launch Configuration:
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(2 Co713sinT 3 ——
,-:liL138LCDI ®  New Target Configuration

2 LCDK.cox Import Target Configuration
@ ¢5416.cof Delete

@ c6713.co

9 dm642.c Rename

7 dm6437.¢ «° Refresh

=

-

v+ Launch Selected Configuration
Set as Default
e Goto Run-> Load -> Load program-> Browse project

e Choose the ‘.out’ file of your project from debug folder and OK.
e Now you can RUN and plot graphs in the same way as in previous procedure.
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II1. Procedure to work with REAL TIME program (FIR filter):

R1: Create a Project:
Project name: any name (for example I have given as FIR)

Family : C6000

Variant : <LEAVE IT BLANK> | DSK6713

Connection : Spectrum Digital DSK-EVM-eZdsp onboard USB Emulator (if using
the kit)

Advanced settings:
Linker Command file: C:\CCStudio_v3.1\tutorial\dsk6713\hello1\hello.cmd
Runtime Support Library: C:\CCStudio_v3.1\C6000\cgtools\lib\rts6700.1ib

Then select empty project, Then click on finish .

New CCS Project - o IEN

CCS Project »

Create a new CCS Project.

D(o

Project name: | FIR

Output type: | Executable v

Use default location

G:\C6713wks\FIR Browse
Device
Family: C6000 v
Variant: C671x Floating-point DSP v | TMS320C6713 v
Connection: | Spectrum Digital DSK-EVM-eZdsp onboard USB Emulator v

v Advanced settings

Device endianness: little v
Compiler version: TIv744 v More...
Output format: legacy COFF v

Linker command file: CA\CCStudio_V3.1\tutorial\dsk6713\hello1\he v Browse...

Runtime support library: = C:\ti\ccsv5\tools\compiler\c6000_7.4.4\lib\rt: v Browse...

» Project templates and examples
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R2: Create a source file
Please refer the step 2 of non real time program, give the source file name as FIR.C.

//FIR.c
#include "C:\CCStudio_v3.1\C6000\dsk6713\include\dsk6713.h"
#include "C:\CCStudio_v3.1\C6000\dsk6713\include\dsk6713_aic23.h"

float filter Coeff]] = {

0.000000,-0.001591,-0.002423,0.000000,0.005728,

0.011139,0.010502,-0.000000,-0.018003,-0.033416,-0.031505,0.000000,

0.063010,0.144802,0.220534,0.262448,0.220534,0.144802,0.063010,0.000000,

-0.031505,-0.033416,-0.018003,-0.000000,0.010502,0.011139,0.005728,

0.000000,-0.002423,-0.001591,0.000000

15

static short in_buffer[100];

DSK6713 AIC23 Config config = {\
0x0017, /* 0 DSK6713 AIC23 LEFTINVOL Left line input channel volume */\
0x0017, /* 1 DSK6713 AIC23 RIGHTINVOL Right line input channel volume */\
0x00d8, /* 2 DSK6713 AIC23 LEFTHPVOL Left channel headphone volume */ \
0x00d8, /* 3 DSK6713 AIC23 RIGHTHPVOL Right channel headphone volume */\
0x0011, /*4 DSK6713 AIC23 ANAPATH Analog audio path control */  \
0x0000, /* 5 DSK6713_AIC23 DIGPATH Digital audio path control */ \
0x0000, /* 6 DSK6713_AIC23 POWERDOWN Power down control */ \
0x0043, /* 7DSK6713 AIC23 DIGIF  Digital audio interface format */\
0x0081, /* 8 DSK6713_AIC23 SAMPLERATE Sample rate control */ \
0x0001 /* 9 DSK6713_AIC23 DIGACT Digital interface activation */ \

15

/*

* main() - Main code routine, initializes BSL and generates tone

*/

void main()

{
DSK6713 AIC23 CodecHandle hCodec;
Uint32 1_input, r_input,]_output, r_output;

/* Initialize the board support library, must be called first */
DSK6713_init();

/* Start the codec */
hCodec = DSK6713 AIC23 openCodec(0, &config);

DSK6713 AIC23_setFreq(hCodec, 1);
while(1)
{ /* Read a sample to the left channel */
while (IDSK6713 AIC23 read(hCodec, &1 _input));

/* Read a sample to the right channel */
while ('DSK6713_AIC23 read(hCodec, &r_input));

1 output=(Int16)FIR FILTER(&filter Coeff,l input);
r_output=(Int16)FIR_FILTER(&filter Coeff ,r_input);

/* Send a sample to the left channel */
while ('DSK6713_AIC23 write(hCodec, 1_output));

/* Send a sample to the right channel */

while ('DSK6713_AIC23 write(hCodec, r_output));
}
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/* Close the codec */
DSK6713 AIC23 closeCodec(hCodec);

§
signed int FIR_FILTER(float * h, signed int x)

{

int i=0;

signed long output=0;

in_buffer[0] = x; /* new input at buffer[0] */

for(i=31;i>0;i--)
in_buffer[i] = in_buffer[i-1]; /* shuffle the buffer */

for(i=0;i<31;i++)
output = output + h[i] * in_buffer[i];

return(output);

}

R3: Adding library files
Go to project->add files as shown in below:

Navigate BY{E=# Run Scripts Window Help

Q - 7% New CCS Project
CCS Example Projects
w &3

010 Build All Ctrl+B
m Build Configurations » Read a san
L
Build Project le ('!'DSK6
es
Build Working Set »
j.emd |
Clean... Read a san

Build Automatically le (!'DSK67
Show Build Settings...

1 output=
Add Files... —outp
r_output=

e

{29 Import Existing CCS Eclipse Project

20C6713.c

fend a san

N kel

=3 Import Legacy CCSv3.3 Project

Then you have to add bsl and esl library files. These files you will get in below
mentioned paths.
e BSL(Board support library file)

Path : C:\CCStudio_v3.11C6000\dsk6713\lib\dsk6713bsl.lib
e CSL(Chip support library file )

Path: C:\CCStudio _v3.1\C6000\csl\lib\csl6713.1ib
You can see these files added to your project as shown below:




Digital Signal Processing

File Edit View Navigate Project Run Script:
R i
Project Explorer 52 ===

(«

? 52 Twvortopace]

WA pALure - Debug]
I Includes
| £ C6713.cmd
#- g fir.c
B, csl6713.lib
(%) TMS320C6713.coxml [Active]
linear

a7
s

1
Q

(i
# &

+

o S
i+

R4: Setting Build properties

» Go to project->properties , under Build=> C6000 Compiler=>include
options now click on add as shown in below:

>

¥ Properties for fir1

Include Options =R
[+ Resource

General

Lab Manual

(=]

(= Build Configuration: |Debug [ Active ]

|| [Manage Configurations... ]
(= C6000 Compiler

Basic Options

Symbolic Debug Options
Language Options

Parser Preprocessing Options
Predefined Symbols
Diagnostic Options

Runtime Model Options
Optimizations

Add dir to #include search path (--include_path, -I) @ ) S
${CG_TOOL ROOT}include"

» Then click on file system and go to this path
C:\CCStudio_v3.11C6000\csl\include, then ok.

Basic Options

Symbolic Debug Options )
Language Options Add dir to #include search path (--include_path, -I)
Parser Preprocessing Options L o do

Predefined Symbols
Include Options
Diagnostic Options Directory:
Runtime Model Option]
Optimizations
Entry/Exit Hook Optiol
Feedback Options
Library Function Assur
Assembler Options I
File Type Specifier
g:feacﬁlotr:ilip::::i;ions Specify a preinclude Ffile (--preinclude)
NDvnamic | inkinA Stinnnrk Ontinns ‘

& Edit directory path

'C:\CCStudio_v3.11C6000\csl\include" J

OK ] [ Cancel ] [Workspace... ] [File system... ]
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» Now again under same build go to Build=> C6000 Compiler—-> Predefined
symbols , Then again click on add(On top right side Plus indication in green
color symbol ). Then type as "CHIP_6713” then apply ok as shown in below

weneral
= Build Configuration: |Debug [ Active ] v [Manage Configurations. .. ]
=l C6000 Compiler
Basic Options
Symbolic Debug Options
Language Options Pre-define NAME (--define, -D) <) w) 85
Parser Preprocessing Options
Predefined Symbols e Edit Dialog
Include Options
Diagnostic Options
Runtime Model Option)
Optimizations
Entry/Exit Hook Optiol
Feedback Options
Library Function Assui
Assembler Options
File Type Specifier
Directory Specifier
Default File Extensions
Dynamic Linking Support Options
Command Files
MISRA-C:2004
+ C6000 Linker
Debug

Pre-define NAME (--define, -D)

(l

Undefine NAME (--undefine, -U)

4

<

|v

(?) Show advanced settings [ OK ] [ Cancel ]

R5: Now Build, Debug and RUN the project as mentioned in NR3, NR4 and NRS5.
Connect CRO through stereo cable to the LINE OUT.
Connect a Signal Generator through stereo cable to the LINE IN Socket.
The signal will be attenuated beyond 1 KHz for this program.

In the same way all the Real-Time projects can be done just by replacing the
corresponding source files.
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Experiment -7

Aim: To verify Linear Convolution using TMS320C6713 DSK
Equipments Required: PC, TMS320C6713 DSK, Code composer Studiov5.5

Theory: These operations can be represented by a Mathematical Expression as
follows:

00

ylnl= Y x{k]hln—k]

k=—0

X[ ]= Input signal Samples
h[ ]= Impulse response co-efficient.
y[ ]= Convolution output.
n = No. of Input samples
h = No. of Impulse response co-efficient.

Algorithm:

Algorithm to implement ‘C’ program for Convolution:

Eg: x[n] =

Where: n=4, k=4.  ;Values of n & k should be a multiple of 4.
If n & Kk are not multiples of 4, pad with zero’s to make
multiples of 4
r=n+k-1 ; Size of output sequence.

=4+4-1
=17.
r= 0 1 2 3 4 5 6
n=0  x[0]h[0] x[0]h[1] x[O]h[2] x[O]h[3]
1 x[1]h[0] x[1]h[1] x[1]h[2] x[1]h[3]
2 x[2]h[0]  x[2]h[1] x[2]h[2] x[2]h[3]
3 x[3]h[0] x[3]h[1] x[3]h[2] x[3]h[3]
Output: ylrl ={1, 4, 10, 20, 25, 24, 16}.
Procedure:

1) Stepl: Creation of a Target configuration
a. File>new->target configuration , you will get window as shown in

figl. You can give any target name with extension .ccxml (for example
here I have taken target name as 6713.ccxml) after giving the name
click on finish.

Once you click on finish you will get general setup window as shown below in

fig2. In the general setup you have select device and connection as mentioned

below.

Connection : Spectrum Digital DSK-EVM-eZdsp onboard USB

Emulator

Board or Device: TMS320C6713
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Then click on SAVE
2) Step 2: Launch the Target Configuration
Go to view from toolbar
View=> target configuration, you can see your target name under user
defined as circled in fig 3 .
Here under user defined it is showing 6713.ccxml it is my target.
3) Step 3: Connecting the target
go to Run—>connect target as shown in below.
Note: on mail CCS window there are two prospective are there one is CCS
Debug and one more is CCS edit . as shown in below diagram fig 6 . in CCS
debug it contain all option related to target and in CCS edit it contain all
options related to projects( source, lib etc).
4) Step 4: Creation of a project
First click on CCS edit as shown below
Then go to File>new—>CCS Project as shown in below figure.
Then make as changes as mentioned
Project name: any name (for example I have given as linear)
Family : C6000
Variant : C671xFloating-point DSP TMS320C6713
Connection : Spectrum Digital DSK-EVM-eZdsp onboard USB
Emulator
Then select empty project, Then click on finish.
5) Step 5: Create a source file
File->new=> source file
Source file: give any name with extension .c(here I have given as lin.c) as
sown in
Then click on finish.
Now write a code on workspace, then go to file=>save.
6) Step 6: Build the project
Go to Project->Build Project as shown in Fig 11below.
7) Step 7: Run the project
Switch to CCS debug prospective as shown in below figure.
Then go to Run—>resume to run the program.
You can see output of linear convoluted samples as in watch window by
typing in expression as mention below.
View—>expression
Then type output variable name y then enter as shown below.
8) Step 8: Plotting a graph
Go to Tools>Graph—>Single Time , then make graphical properties change
as per program here in figl4 I had made changes which round up with red line
. this changes applicable for linear convolution program. Then click ok.
Program:

/* program to implement linear convolution */

#include<stdio.h>

#define LENGHT1 6 /*Length of i/p samples sequence*/
#define LENGHT2 4 /*Length of impulse response Co-
efficient */
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int x[2*LENGHT1-1]={1,2,3,4,5,6,0,0,0,0,0}; /*Input

Signal Samples*/

int h[2*LENGHT1-1]={1,2,3,4,0,0,0,0,0,0,0}; /*Impulse
Response Co-efficient*/

int y[LENGHT1+LENGHT2-1];

main ()

{

int i=0,3;

for (i=0;i< (LENGHT1+LENGHT2-1) ; i++)
{

y[i]=0;

for (j=0;]j<=i;j++)

y[il+=x[j]1*h[i-3]’
}

for (i=0;i< (LENGHT1+LENGHT2-1) ;i++)
printf ("8d\n",y[i]) ;

}

Results:

Thus, the Linear Convolution of two given discrete sequence has been performed. The
input sequences are given in the program and the output will be displayed in the CCS
software.

Input x[n] =

S&
S8
S
Nl
==

Output: y[n] =
Now configure the Graphical window as shown below

=5 (P55 CCS Debug | B2 ¢ >

] || Bac Single Time -0 | Rac Single Time -1 3 = 0
=
oy B SR SERS K E # e - BH| E 3

Data |
as
40 —
37
34 A
31
28
25 4
22 J

19 -

16

N
IR AT PP IO T |

! - N S T A S —
+1 +2 +3 +4 +5 +6 +7 +8 +9 +10 +11 +12 +13 +14 +15 +16 +17 +18 +19
sample

o
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Discussions on results:

Thus we have verified the Linear Convolution in Code composer studio environment
by writing a C program.

From the results students will be able to

1) Discuss the steps required to interface TMS320C6713 Kit with Code
composer studio environment.

2) Discuss the changes in the program to get the input sequences from user.

3) Discuss the steps required in graphical property dialog of the Code
composer studio for graphical visualization of linear convolution output
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Experiment -8

Aim: Generation of Sine wave and square wave using TMS320C6713 DSK and Code
Composer Studio.

Equipments Required: PC, TMS320C6713 DSK, Code composer Studiov5.5
Theory:

Sinusoidal Wave: The sine wave or sinusoidal wave is a mathematical curve that
describes smooth repetitive oscillations. It can be represented in mathematical form as

y(t) = Asint(wt + @)
Where
A=Amplitude in V.
w=angular frequency
¢=Phase in radins.

Square Wave: The square wave is a non sinusoidal periodic wave form which is
represented as infinite summation of sinusoidal waves in which the amplitude
alternates at a steady frequency between fixed minimum and maximum values with
the same duration at maximum and minimum.

Algorithm:

1) Define frequency in C program.
2) Generate the signals using corresponding general formula.
3) Plot the graph in Code Composer Studio.

Procedure for Sinusoidal wave form generation

1) Stepl: Creation of a Target configuration
a. File>new—>target configuration , you will get window as shown in
figl. You can give any target name with extension .ccxml (for example
here I have taken target name as 6713.ccxml) after giving the name
click on finish.
Once you click on finish you will get general setup window as shown below in
fig2. In the general setup you have select device and connection as mentioned
below.
Connection : Spectrum Digital DSK-EVM-eZdsp onboard USB
Emulator
Board or Device: TMS320C6713
Then click on SAVE
2) Step 2: Launch the Target Configuration
Go to view from toolbar
View=> target configuration, you can see your target name under user
defined as circled in fig 3 .
Here under user defined it is showing 6713.ccxml it is my target.
3) Step 3: Connecting the target
go to Run—>connect target as shown in below.
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4)

3)

6)

7)

8)

Note: on mail CCS window there are two prospective are there one is CCS
Debug and one more is CCS edit. In CCS debug it contain all option related to
target and in CCS edit it contain all options related to projects( source, lib etc).
Step 4: Creation of a project
First click on CCS edit as shown below
Then go to File>new->CCS Project
Then make as changes as mentioned
Project name: any name (for example SivewaveGen)
Family : C6000
Variant : C671xFloating-point DSP  TMS320C6713
Connection : Spectrum Digital DSK-EVM-eZdsp onboard USB
Emulator
Then select empty project, Then click on finish.
Step 5: Create a source file
File=>new-> source file
Source file: give any name with extension .c(here I have given as
SivewaveGen.c). Then click on finish. Now write a code on workspace, then
go to file>save.
Step 6: Build the project
Go to Project->Build Project
Step 7: Run the project
Switch to CCS debug prospective as shown in below figure.
Then go to Run—>resume to run the program.
You can see output of linear convoluted samples as in watch window by
typing in expression as mention below.
View->expression
Then type output variable name y then enter as shown below.
Step 8: Plotting a graph
Go to Tools=>Graph->Single Time , then make graphical properties change
as per program here in figl4 I had made changes which round up with red line
. this changes applicable for linear convolution program. Then click ok.

Program:

/* program for sinewave generation */

#include<stdio.h>
#include<math.h>

#define freq 400
float m[128];

main ()
{
int n=0;
for (n=0;n<127;n++)
{
m[n]=sin(2*3.14*freq*n/24000)
printf (“$£” ,m[n]) ;
}
}
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Program for Square wave Generation

/* program for Squarewave generation */

#include<stdio.h>
#include<math.h>
#define freq 500
float m[81];

main ()
{
int n=0;
for (n=0;n<21;n++)
{
m[n]=5.0
}
for (n=21;n<41;n++)
{
m[n]=-5.0
}
for (n=41;n<61;n++)
{
m[n]=5.0
}
for (n=61,;n<81;n++)
{
m[n]=-5.0

Plot of sine waveform

7 CCSDebug-Code Composer Studio

Fle Edt View Project Run Tools Scrpts Window Help
v G- 6 v

i SingleTime-0 &3 &) Console

B 1m0
)
91004041 4 A Y oy
(R gy i )
g [ { \ [\
o0 { \ | A A
6100401 4 4 4
sunaon { { f
oo | / \
310400 < [ / \
¢ [ | 1] k
200001 1 | \
11004041 4f 4 [ 1}
f \ \
1000002 4 \ | |
90002 4 \ [ \ /

olefs

[ [ % CCSDebug | 5

RFILCY N EILE R

m
w

1900401 k‘ ‘% k“ € #\ (
| / \
20004041 A ! A f i
\ { | |
39000041 - 4 [ \
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Results:

Thus, the waveform generation on sine wave and square wave is performed in Code
composer environment by using a C program. Output will be displayed in the
graphical window of CCS software.

Now configure the graphical window as shown below for Sine wave generation .the
same procedure can be followed for square wave generation.

Discussion on Results:

Thus we have performed the waveform generation in Code composer studio
environment by writing a C program.

From the results the student will be able to

1) Discuss the steps required to interface TMS320C6713 Kit with Code
composer studio environment.

2) Discuss the changes in the program to get the input sequences from user.

3) Discuss the steps required in graphical property dialog of the Code
composer studio for graphical visualization of the sine wave and square
wave output.
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Experiment -9

Aim: Computation of DFT and DIT FFT using TMS320C6713 DSK and Code Composer
Studio.

Equipments Required: PC, TMS320C6713 DSK, Code composer Studiov5.5
Theory:

Discrete Fourier Transform (DFT) is used for performing frequency analysis of discrete
time signals. DFT gives a discrete frequency domain representation whereas the other
transforms are continuous in frequency domain. The N point DFT of discrete time signal
x[n] is given by the equation

j2sm

N-1
X(k)=>xnle ¥ : k=012 N-1
n-0

The inverse DFT allows us to recover the sequence x[n] from the frequency samples

1 N-1 12.1.11:
x[n],wzx{n]e ¥ - n=0,12,.N-1
k=0

A Fast Fourier transform (FFT) is an efficient algorithm to compute the discrete Fourier
transform (DFT) and its inverse. There are many distinct FFT algorithms involving a
wide range of mathematics, from simple complex number arithmetic to group theory and
number theory.

A DFT decomposes a sequence of values into components of different frequencies. This
operation is useful in many fields (see discrete Fourier transform for properties and
applications of the transform) but computing it directly from the definition is often too
slow to be practical. AnFFTis a way to compute the same result more quickly:
computing a DFT of N points in the naive way, using the definition, takes O(N2)
arithmetical operations, while an FFT can compute the same result in only O(N log N)
operations. The difference in speed can be substantial, especially for long data sets where
N may be in the thousands or millions—in practice, the computation time can be reduced
by several orders of magnitude in such cases, and the improvement is roughly
proportional to N / log(N). This huge improvement made many DFT based algorithms
practical; FFTs are of great importance to a wide variety of applications, from digital
signal processing and solving partial differential equations to algorithms for quick
multiplication of large integers. The most well known FFT algorithms depend upon the
factorization of N, but there are FFTs with O(N log N) complexity for all N, even for
prime N.
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Algorithm:

1) Enter the length of the sequence for which DFT need to be computed.
2) Enter the sequence data as per the length of the sequence 4 or 8.

3) Compute the 4 point or 8 point DFT using the code.

4) Get the results in the Console window.

Procedure for DFT Computation

1))

2)

3)

4)

5)

6)

7)

Step1: Creation of a Target configuration
a. File>new—>target configuration , you will get window as shown in
figl. You can give any target name with extension .ccxml (for example
here I have taken target name as 6713.ccxml) after giving the name
click on finish.
Once you click on finish you will get general setup window as shown below in
fig2. In the general setup you have select device and connection as mentioned
below.
Connection : Spectrum Digital DSK-EVM-eZdsp onboard USB
Emulator
Board or Device: TMS320C6713
Then click on SAVE
Step 2: Launch the Target Configuration
Go to view from toolbar
View=> target configuration, you can see your target name under user
defined as circled in fig 3 .
Here under user defined it is showing 6713.ccxml it is my target.
Step 3: Connecting the target
go to Run—>connect target as shown in below.
Note: on mail CCS window there are two prospective are there one is CCS
Debug and one more is CCS edit. In CCS debug it contain all option related to
target and in CCS edit it contain all options related to projects( source, lib etc).
Step 4: Creation of a project
First click on CCS edit as shown below
Then go to File>new—>CCS Project
Then make as changes as mentioned.
Project name: any name (for example DFTComput)
Family : C6000
Variant : C671xFloating-point DSP TMS320C6713
Connection : Spectrum Digital DSK-EVM-eZdsp onboard USB
Emulator
Then select empty project, Then click on finish.
Step 5: Create a source file
File->new=> source file
Source file: give any name with extension .c (here [ have given as
DFTComput.c). Then click on finish. Now write a code on workspace, then go
to file>save.
Step 6: Build the project
Go to Project->Build Project
Step 7: Run the project
Switch to CCS debug prospective as shown in below figure.
Then go to Run—=>resume to run the program.
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You can see output of linear convoluted samples as in watch window by
typing in expression as mention below.
View—>expression
Then type output variable name y then enter as shown below.
8) Step 8: Plotting a graph
Go to Tools=>Graph->Single Time , then make graphical properties change
as per program here in figl4 I had made changes which round up with red line
. this changes applicable for linear convolution program. Then click ok.

Program:
/* program for DFT Computation */

#include<stdio.h>

#include<math.h>

int N,k,n,i;

float pi=3.1416, sumre=0,
sumim=0,out_real[8]={0.0},out_imag[8]={0.0};
int x[32];

void main(void)
{
printf ("enter the length of the sequence \n");
scanf ("%d", &N) ;
printf ("enter the sequence\n");
for (i=0;i<N;i++)
scanf ("%d",&x[1i]) ;
for (k=0;k<N;k++)
{
sumre=0;
sumim=0;

for (n=0;n<N;n++)

{
sumre=sumre+x[n] *cos (2*pi*k*n/N) ;
sumim=sumim-x[n] *sin (2*pi*k*n/N) ;

}

out_real [k]=sumre;

out_imag[k]=sumim;

printf ("X ([%d])= \t$£\t+\t%£i\n" ,k, out_reall[k],out_imagl[k]);

Results:

enter the length of the sequence

4

enter the sequence

1

2

3

4

X([el])= 10.000000 + 0.0000001
X([1])= -1.999963 + 2.0000221
X([2])= -2.000000 + 0.0000591
X([3])= -2.000108 + -1.9999341
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Program for the DIT FFT Algorithm:

#include<stdio.h>
#include<conio.h>
#include<math.h>
#idefine SWAP(a,b)var=(a); (a)=(b); (b)=var;

void main()

{

int N,n,m,j, k,i,p;

float data[200],reall,imagl,real2,imag2,var;
float costheta,sintheta, t,Theta;

clrscr();
printf ("\n\t\t Readix-2 DIT FFT algorithm\n\n");

printf ("\n\n Enter the number of samples in the sequence x(n) , N=");
scanf ("%d", &N) ;

printf ("\n\n Enter the Samples of the Sequence x(n):\n");
printf("\n Real part Imaginary part");

for (n=1;n<=N;n++)
{
printf ("\n x(%d)=",n-1);
scanf ("$£%f",&data[2*n-1],&data[2*n]) ;
}
n=N<<1;
j=1;

for(i=1l;i<n;i=i+2)
{
if (3>1)
{
SWAP (data[j] ,data[i]) ;
SWAP (data[j+1] ,data[i+1]);
}
m=n>>1;
while (m>=2 && j>m)
{
j-=m;
m>>=1;
}
j+=m;

}

k=1;m=1;t=0.0;
while ((N/ (2*k))>=1)
{
p=pow (2,m) ;
n=1;
Theta=((2*M_PI)/(float)p) *t;
costheta=cos (Theta) ;
sintheta=sin (Theta) ;

for (i=1;i<=2*N;)

{

reall=data[i]+costheta*data[i+p]+sintheta*data[i+1+p]
imagl=data[i+l]+costheta*data[i+1+p]-sintheta*data[i+p];
real2=data[i] -costheta*data[i+p]-sintheta*data[i+1+p];
imag2=data[i+l]-costheta*data[i+1+p]+sintheta*data[i+p];
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data[i]=reall;
data[i+l]=imagl;
datal[it+p]=real2;
data[i+p+l]=imag2;

if (n<k)
{
t=t+1;
Theta=((2*M_PI)/(float)p) *t;
costheta=cos (Theta) ;
sintheta=sin (Theta) ;
}
else
{
i=i+p+2;
n=1;
t=0;
Theta=((2*M_PI)/(float)p) *t;
costheta=cos (Theta) ;
sintheta=sin (Theta) ;
}
}
k=k<<1;
m++;
}

printf ("\n\n Output of DIT FFt is as follows:\n");
printf ("\n\n Real part of X[k] Imaginary part of X[k]");
for (n=1;n<=N;n++)
{
printf ("\n%£f\t\t %f ",data[2*n-1],data[2*n]);
}
}

Results:

Enter the number of samples in the sequence x(n) ,N=8
Enter the samples of the sequence x(n):

Real Part Imaginary Part

x(0)= 0.5 0
x(1l)= 0.5 0
x(2)= 0.5 0
x(3)= 0.5 0
x(4)= 0 0
x(5)= 0 0
x(6)= 0 0
x(7)= 0 0

Output of DIT FFT is as follows

Real part of X(k) Imaginary part of X(k)
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2.

0.

Discussion:

000000

500000

.000000

.500000

.000000

.500000

.000000

.500000

0.000000

-1.207107

0.000000

-0.207107

0.000000

0.207107

0.000000

1.207107

Lab Manual

Thus, the DFT computation is performed for N=4 using the Code composer
environment by using a C program. Output will be displayed in the Console window
of CCS software.
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Experiment -10

Aim: Generating the Responses of Low Pass and High Pass IIR filters using DSP
Trainer Kit (TMS320C6713)

Equipment Required: PC Host (PC) with windows (95/98/Me/XP/NT/2000),
TMS320C6713 DSP Starter Kit (DSK).Oscilloscope and Function generator, Code
Composer Studio v3.0

Algorithm:

We need to realize the Butter worth band pass IIR filter by implementing the
difference equation y[n] = b0x[n] + blx[n-1]+b2x[n-2]-aly[n-1]-a2y[n-2]
where b0 — b2, a0-a2 are feed forward and feedback word coefficients
respectively [Assume 2nd order of filter].These coefficients are calculated
using MATLAB.A direct form I implementation approach is taken.

1)
2)

3)

4)
5)

6)

Initialize the McBSP, the DSP board and the on board codec.

“Kindly refer the Topic Configuration of 6713Codec using BSL”

Initialize the discrete time system , that is , specify the initial conditions.
Generally zero initial conditions are assumed.

Take sampled data from codec while input is fed to DSP kit from the
signal generator. Since Codec is stereo , take average of input data read
from left and right channel . Store sampled data at a memory location.
Perform filter operation using above said difference equation and store
filter Output at a memory location .

Output the value to codec (left channel and right channel) and view the
output at Oscilloscope.

Step 6 - Go to step 3.

Procedure for Real time Programs:

1.
. Connect a Signal Generator to the LINE IN Socket.

W

Connect CRO to the Socket Provided for LINE OUT.

Switch
p=1.5v

on the Signal Generator with a sine wave of frequency 500 Hz. and Vp-

Now Switch on the DSK and Bring Up Code Composer Studio on the PC.
Create a new project with name codec.pjt.

From the File Menu =» new =» DSP/BIOS Configuration =»select
“dsk6713.cdb” and save it as “xyz.cdb”
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10.

11.
12.

13.
14.

New =[]
Tmam&m|

— Description

c6713.cdb [N cbxlx.cdb cbxxx.cdb

DSKE713 Base Seed

0K Cancel Help

Add “xyz.cdb” to the current project.

Add the given “codec.c” file to the current project which has the main function
and calls all the other necessary routines.

Add the library file “dsk6713bsl.lib” to the current project

Path 2 “C:\CCStudio\C6000\dsk6713\lib\dsk6713bsl.1lib”

Copy files “dsk6713.h” and “dsk6713 aic23.h” from
C:\CCStudio\C6000\dsk6713\include and paste it in current project.

Build, Load and Run the program.

You can notice the input signal of 500 Hz. appearing on the CRO verifying the
codec configuration.

You can also pass an audio input and hear the output signal through the speakers.
You can also vary the sampling frequency using the DSK6713 AIC23 setFreq
Function in the “codec.c” file and repeat the above steps.

Procedure to execute IIR Filter Program

1) Switch on the DSP board.
2) Open the Code Composer Studio.
3) Create a new project
Project > New (File Name. pjt, Eg: IIR.pjt)
4) Initialize on board codec.
5) Add the given above ‘C’ source file to the current project (remove codec.c
source file from the project if you have already added).
6) Connect the speaker jack to the input of the CRO.
7) Build the program.
8) Load the generated object file (*.out) on to Target board.
9) Run the program
10) Observe the waveform that appears on the CRO screen.
11) Vary the frequency on function generator to see the response of filter.

Program:

#include "xyzcfg.h"
#include "dsk6713.h"
#include "dsk6713 aic23.h"

const signed int filter Coeff[] =

{

//12730,-12730,12730,2767,-18324,21137 /*HP 2500 */
//312,312,312,32767,-27943,24367 /*LP 800 */
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//1455,1455,1455,32767,-23140,21735 /*LP 2500 */
//9268,-9268,9268,32767,-7395,18367 /*HP 4000%*/
7215,-7215,7215,32767,5039,6171, /*HP 7000%*/
}

/* Codec configuration settings */
DSK6713_AIC23 Config config = { \
0x0017, /* 0 DSK6713_AIC23 LEFTINVOL Left line input channel volume */

\ 0x0017, /* 1 DSK6713_AIC23 RIGHTINVOL Right line input channel volume
*

& 0x00d8, /* 2 DSK6713_AIC23 LEFTHPVOL Left channel headphone volume */
\ 0x00d8, /* 3 DSK6713_AIC23 RIGHTHPVOL Right channel headphone volume */
\ 0x0011, /* 4 DSK6713_AIC23 ANAPATH Analog audio path control */

\ 0x0000, /* 5 DSK6713_AIC23 DIGPATH Digital audio path control */

\ 0x0000, /* 6 DSK6713_AIC23 POWERDOWN Power down control */

\ 0x0043, /* 7 DSK6713_AIC23 DIGIF Digital audio interface format */
\ 0x0081, /* 8 DSK6713_AIC23 SAMPLERATE Sample rate control */

\ 0x0001 /* 9 DSK6713_AIC23 DIGACT Digital interface activation */

\

bi

/*

* main() - Main code routine, initializes BSL and generates tone

*/

void main()

{
DSK6713_AIC23_CodecHandle hCodec;

int 1_input, r input, 1 output, r output;

/* Initialize the board support library, must be called first */
DSK6713_init();

/* Start the codec */
hCodec = DSK6713 AIC23 openCodec (0, &config);

DSK6713_AIC23_setFreq(hCodec, 3);

while (1)
{ /* Read a sample to the left channel */
while (!DSK6713 AIC23 read(hCodec, &l_input));

/* Read a sample to the right channel */
while (!DSK6713 AIC23 read(hCodec, &r_input));

1 output=IIR_FILTER(&filter Coeff ,1 input);
r_output=1_output;

/* Send a sample to the left channel */
while (!DSK6713 AIC23 write(hCodec, 1 _output));

/* Send a sample to the right channel */
while (!DSK6713 AIC23 write(hCodec, r_output));
}

/* Close the codec */
DSK6713_AIC23_closeCodec (hCodec) ;

}

signed int IIR FILTER(const signed int * h, signed int x1)
{
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static signed int x[6] = { 0, O, O, O, O, O }; /* x(n), x(n-1), x(n-2).
Must be static */
static signed int y[6] = { 0, O, O, O, O, O }; /* y(n), y(n-1), y(n-
2) . Must be static */
int temp=0;

temp = (short int)x1l; /* Copy input to temp */

x[0] = (signed int) temp; /* Copy input to x[stages][0] */

temp = ( (int)h[0] * x[0]) ; /* BO * x(n) */
temp += ( (int)h[1] * x[1]); /* B1/2 * x(n-1) */
temp += ( (int)h[1l] * x[1]); /* B1/2 * x(n-1) */
temp += ( (int)h[2] * x[2]); /* B2 * x(n-2) */
temp -= ( (int)h[4] * y[1]); /* Al/2 * y(n-1) */
temp -= ( (int)h[4] * y[1]); /* Al/2 * y(n-1) */
temp -= ( (int)h[5] * y[2]); /* A2 * y(n-2) */

/* Divide temp by coefficients[AO0] */
temp >>= 15;

if ( temp > 32767 )
{ temp = 32767;

el;e if ( temp < -32767)
{ temp = -32767;

}
y[0] = temp ;

/* Shuffle values along one place for next time */

y[2] = y[1]1; /* y(n-2) = y(n-1) */
y[1] = y[0]1; /* y(n-1) = y(n) */
x[2] = x[1]; /* x(n-2) = x(n-1) */
x[1] = x[0]; /* x(n-1) = x(n) */

/* temp is used as input next time through */

return (temp<<2);
}

Results:
Thus the result can be observer on the CRO for various frequencies.
Discussions on results:

The designing of IIR Low pass and High Pass Filters requires initialization of BSL
codec.

From the results students will be able to
1) Discuss the real time interfacing of the TMS320C6713 Kit by using the
full functionality of the board support library files and BSL Codec.
2) Discuss the effect of changing the value of coefficients for filters.
3) Discuss the steps required to do the connection of CRO and function
generator to TMS320C6713 Kit.
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